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Communicate: SymerteQ

What is SymWriter?

SymWriter is a symbolising word processor that can be used by both teachers and students to
create symbol-supported documents. Symbols provide the with writer visual assistance, reinforcing
meaning and improving confidence. Writers of any age or ability can use the Widgit Symbols to see
the meaning of words, enabling supportive access to new or challenging vocabulary. SymWriter's
flexibility allows you to create documents with an easily customised level of symbol support, and
drop in photos and images to illustrate a document, or use them to replace symbols for more
specificity.

On-screen Grids provide support for emergent writers, who can select words or phrases to be
automatically written into the document. The Grids can be complete activities or word-banks to
support writing. Teachers can edit and personalise ready-made Environments or create their own
from scratch with Design-mode.

SymWriter is fully accessible with support for switch scanning and two switches, touch screens and
speech which can used to hear individual letters, words and sentences, or for proofreading. It also
features Smart Symbolising, which automatically makes intelligent symbol choices and a spell
checker with symbol support.

Features

Full Widgit Symbol Set with 11,000 symbols representing 40,000 English words with free
updates.

Widgit Symbols have a large subject-based vocabulary, can be customized and are suitable
for all ages.

Customise documents with thousands of additional graphics or add your own.

Smart Symbolisation makes intelligent symbol choices based on sentence structure.

Structured writing grids support emergent writers with a full editor to create your own.

Fully accessible with speech and touch screen support, switch scanning with up to two
switches.

Free Trial
21 day free trial is available from downloads.widgit.com

Minimum System Requirements

Windows XP, Vista, Windows 7, Windows 8

Pentium processor (800MHz min, Pentium 4 or above at 1Ghz min preferred)
256Mb RAM min, preferably 512MB or above and Sound Card

1Gb Mb hard disk space.

Minimum resolution of 1024x768.
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New Features of Version 2

Integration with SymWriter Online
Create, save and share symbol-supported documents in the cloud.

New specialist Language Pictures
Support language development using a new collection of graphics that help convey meaning.

New default font: FS Me
New highly accessible default font.

Format Painter
Copy and paste formatting properties across Documents and Environments.

Set symbol defaults
Configure your personal symbol preferences, or stop certain symbols from appearing in your
document altogether.

New method for dropping in graphics
Insert graphics into your document with greater control and precision.

Soft returns
Change the way you structure your writing.

More symbol control
See the meaning of every word combination as it is typed.

Double side panels
Configure your SymWriter layout to suit how you would like to work.

Split cells
More freedom when editing Grids.

Resize individual rows and columns
Modify your Grids and Cells with drag points to create the exact layout you want.

Copy actions across multiple Cells
Apply Cell actions across as many items as you like.

Tab between Cells
Move from Cell to Cell more quickly.

Recently used actions list
Easy access to your most recently used actions.

Session defaults for Grids and Stages
Automatically store your preferences for your Environment's appearance.

New switch scanning features
Set up a personalised configuration for Switch users.

New launcher
Create different interfaces to customise the program for your users.

New Wordlist Manager
Manage and modify how your symbols and wordlists work.
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Integration with SymWriter Online

Create, save and share symbol-supported documents in the cloud.

What is SymWriter Online?

SymWriter Online allows you to create, save and share symbol-supported documents in the
cloud. SymWriter 2 and SymWriter Online documents completely compatible for total flexibility.

Store and manage your documents online

Access your work from anywhere with an internet connection
Create new documents

Upload and download documents to work with SymWriter 2.
Make documents public to share with anyone

SymWriter Online contains all of the document writing features of SymWriter 2.

More Information on Opening SymWriter Online Documents on Page 70

pr———— S Ele [6 Yow Hatery Boctmuts Teoh bep
D betogmasniss S | s n O Symweter Onlne |+

SymWriteronline “*

Documents  Wordlists  Account Settings My Published Files

Lppanmees  Lnod < & b symastenc om - G R

Foioee Roct

£Leofme P ‘
Write in  Symbols in a web browser. \
e

You can upioad photos.

o i . + A @ e
.:.nr-/n-v)f mma store  your documents in the cloud

dodgdgogagogoaogoaaoa g
Fffffifiii5§°

auaunanauannnn gy
&

[T T | [ et o s okt ==

New specialist Language Pictures

Support language development using a new collection of graphics
that help convey meaning.

SymWriter now features an additional 339 graphics that
can be used to support language development. The
graphics can be used to help convey the meaning of:
prepositions, opposites, sequences, and sentences such
as (subject — verb — objects).

These graphics can be accessed from the Language
Pictures folder in the Graphics Browser and they also
feature in the SymWriter example files: Picture 1 — 5.

Images in the Language Pictures set were developed by
Alan Birch (alanbirch@blueyonder.co.uk) and included
with permission from Sandwell and West Birmingham
hospitals NHS Trust.
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New default font: FS Me

New highly accessible default font.

SymWriter now features a default font that was designed by Fontsmith, and endorsed by Mencap to
aid legibility for those with learning disabilities: FS Me.

4 7o FSme * 14 ~ W B l u ]: 1: Symbolsze: 12 « !g:’

o WK ot T @

The quick brown fox jumpsover the lazydog. |

| e

You can find out more about FS Me at: www.fontsmith.com/projects/portfolio/mencap-fs-me.cfm

NOTE: If you want to use the FS Me font in programs other than SymWriter 2, you will need to
purchase alicense for the font.

Format Painter

Copy and paste formatting properties across Documents and
Environments.

£ £ The Format Painter is a new tool that can be used to copy the formatting properties
(font, colours, symbol size, text size etc,.) from any content in your Document or Environment. Using
the Format Painter, you can easily ensure consistent formatting throughout your writing and grids.

T & 0 @

rhing elephant 2 eleph'm#

Setting symbol defaults

Configure your personal symbol preferences, or stop certain
symbols from appearing in your document altogether.

Swbcs  |usractics —In SymWriter 2, you can update your symbol preferences straight from the
“ exupsmees || Symbol Chooser. If you would like a specific symbol to appear whenever
: . you type a particular word, simply right-click and set it as the default. The
d next time you type the word, SymWriter will detect if it is being used in the

= @) I same way (e.g. as a houn or a verb) and show your chosen symbol.

<o

Set this as the Default Symbol

If you don't want a symbol to appear at all for a particular word, set the
= default symbol to 'No symbol'. This can be useful for people who are new
to symbols where abstract symbols like 'a’, ‘the' and 'but' could be a

distraction.
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New method for dropping in graphics

Insert graphics into your document with greater control and
precision.

Whether you are adding graphics, symbols or images from your computer or the Internet; you will
now have greater control over where they can be inserted.

Version 1

: " In SymWriter 1, you would have to decide whether you were inserting a graphic or

replacing a symbol and click the appropriate button. Then, if you were inserting a graphic, the only
indication of where the graphic might appear in the document would be the thumbnail attached to
the mouse cursor.

G A D whizd

walked through the forest Iookmg for flowers

Version 2

In SymWriter 2, you can simply select a graphic or symbol from the Symbol Chooser, then use the
grey positioning box that appears to accurately insert the image wherever you want it to appear in
your document.

Drop over an empty space - the image becomes an illustration

HL O mk ¢ Wit T o ool

walked through the forest looking for flowers walked through the forest looking for flowers

Drop over a symbol - the image replaces the symbol

for flowers | for flowers |
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Soft returns

Change the way you structure your writing.

You will now be able to use soft returns (Shift + Enter) in your writing.

If, for example, you would like to use a paragraph graphic and start every new sentence on a hew
line, a soft return will enable you to do so without the next sentence starting on a new paragraph
(underneath the graphic).

Anubis is the Greek name for a jackel-headed god.
He is associoted with mumeification and the afterlife in Egyption mythology.
In the oncicnt Egyption languoge, Anubis is known os Inpu.
7 The cldest known mention of Anubis is in the Old Kingdom pyramid texts.
A He is aszociated with the burial of the king.

He wos the most important god of the Dead but wes replaced by Osiris

More symbol control

See the meaning of every word combination as it is typed.

The Symbol Chooser will detect all the potential symbols associated with a word or group of words
as they are typed, and will offer all possible combinations of symbolisation.

Original SymWriter:  (no option for ‘walking stick')

el
Cl

bush walking ~stick el =
:\m]n
SymWriter 2: (all options with labels)
=1 symboss | Graphis
\f\\\\mmsm
walking stick
Wl gl
® "\ Ne
bush walking  stick bush walkng
AN
walking
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Double side panels

Configure your SymWriter layout to suit how you would like to work.

You can now maximise the space at the side of the Document or Environment by choosing to show
a Double Panel that will display both the Symbols tab and Graphics tab simultaneously.

Graphics Panel Symbols Panel Double Panel
Symbs | Gachar | Symbah | Geptes Symbols and Grachas |
Eyrvee| (R s s—

) Pk Symbes

:?mx’?;f 5 @E@_& @k@
o Ng = i
wao - \

7y
£ % 9

bad blackbed bloe

3

\

4

. Mr
w VA (o
MN:)’ bhuefly  beachiora. [ Graphics ]
[
e § N
oo Bl s '9 Areg A

MG o W;;
g

Badger bt bear
comed  comel ] - P
\ PN
P = x \
| | My Pchres

My Pchres |
Widot Pctres Frd Symeal | Wdpt Ptres
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Split Cells

More freedom when editing Grids.

In SymWriter 1, the options for splitting cells in Design Mode were limited. Now when you are
creating Environments, you can split any Cell or multiple Cells at once. You can split Cells vertically
or horizontally, regardless of whether they have previously been merged. The split Cells will inherit
any formatting properties that have been applied to the Cell or Cells they were created from.

; F split Cell Horizontally
[ split Cell vertically

Original Grid Split Cell horizontally Split Cell vertically

Resize individual rows and columns

Modify your Grids and Cells with drag points to create the exact
layout you want.

You can quickly customise the size of specific Cells in Grids while designing an Environment. This
can be achieved by simply highlighting a Cell (or Cells) and then using the drag points around the
border of the selection.

This can be useful if you would like a Grid featuring sentence starters in the first column of cells
followed by single word sentence closers.

SymWriter 2 User Guide Page 13



Copy actions across multiple cells

Apply Cell actions across as many items as you like.

You can copy the assigned Actions from any Cell or Button
Z‘ nend cel confents for the purpose of adding them to others. This is
-'!-': Speak sentence particularly useful when you have many Cells in an
“ Send a return Environment that you wish to function in the same way.

(B omat] [ By |

Tab between Cells

Move from Cell to Cell more quickly.

When typing content into Cells, you can use the Tab key on your keyboard to swiftly move from one
Cell to the next, from left to right. If you want to move in the reverse direction, you can hold the Shift
key and press Tab.

Recently used actions list

Easy access to your most recently used actions.

Available Actions

M Al SymWriter 2 keeps a list of your most recently used
[ _ actions, so you have quick and easy access to them
@ Send a graphic e when creating environments.

/1 Send cell contents L
2 Send a return
T Send cell text
& New paragraph -

Description:

Sends the graphic in the current cell to the document.
This command is only valid if there is a graphic in the
cell,

‘Add * ‘
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Session defaults for Grids and Stages

Automatically store your preferences for your Environment’s
appearance.
Whilst making an Environment, SymWriter will remember your Grid and Stage properties, such as

colours and borders, so that when you make the next item the properties will be the same. This
makes it easy to create consistent, good-looking Environments.

LB

New switch scanning features

Set up a personalised configuration for Switch users.

There are now more features for switch users including directional scan mode, the ability to use the
mouse as a switch and customisable settings for auditory scans, automatic scan speeds and
coloured indicators.

New launcher

Create different interfaces to customise the program for your users.

The new launcher presents users with easy to
navigate options for how they intend to use
SymWriter.

Users can set up a completely personalised
SymWriter account for themselves with an
accompanying user icon of their choice.

Full Toolbars

[ owoge.. |
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New Wordlist Manager

Manage and modify how your symbols and wordlists work.

The Wordlist Manager provides an opportunity to manage and create your own wordlists.
A wordlist is a file that links words with graphics. If you type "cat" in Symbol Mode while using
SymWriter, the loaded wordlist will automatically display the graphic associated with the word "cat".

By using the Wordlist Manager, you will be able to refine the way that SymWriter works; customising
wordlists for your particular activity or personal vocabulary.
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Starting SymWriter

To open the SymWriter go to the Windows start menu, then choose:
“All programs > Widgit > SymWriter > SymWriter”

Or click on the SymWriter shortcut on your desktop:

SymWriter

The Launcher

When you start the program you will be presented with the launcher screen.

From the launcher you can select the way that you want to use SymWriter for your current session.
You can:

e Write A Document
e Use An Environment
e Design An Environment

NOTE: You can choose to hide the Design An Environment interface by using the Launcher
menu at the launcher and deselecting the option Show the Designer Button.

l Launcher | Help

Show the Designer Button

(Y

Goiﬁ‘municatets 7 l’ﬁrﬁer

You can also:

e Choose to view either the product manual, the folder containing help sheets or a 'Getting
Started' tutorial in the form of an Environment with the Help and Tutorials button
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e Visit the SymWriter Web Page at www.widgit.com with the Visit The Web button

EWidgit == 8= owdgtican @ &
» ; Yo bpyeee W o gt 3 A feberanan wenks Promet

Qv

Communcate Symitiote

’1;.3‘.]
st Weicome To Communicate: SymWriter
Easy symbol writing for averyone

L

Need More Liconces?

Speca Lasnico L<enly
Eacen Nige Acetetse

S 31 maee shame

s Online
To downinad the Lautest wrion of Comemunc ite Gymuster shedie
1ect 3 Ianguage verien bekow TRAINING
ECHERT NG - i Wt s FREE e g sessons
== = N e
- 55 GRS Bealabiny o IngAter or 3 Je9ean
Getting Started? Technical Support
sl o Yideo Tatocas ] * DutalEon 200 ACaten Gadtd
s teigihesty Sy © Hauts
o Dacgie Eneaorems o Techain FAQ

Choosing Toolbar Interfaces

Choose an Interface To Use

Environment
Toolbars

Writing Toolbars

Full Toolbars

Tom's Toolbars

[ ok ]

If you are going to Write A Document or Use An Environment, you will need to make sure you
have the appropriate Interface selected from the bottom panel. Use the Change... button to select
an interface. This allows you to choose the type of interface for a student to use, or the type suitable
for experts, such as teachers. More about the Toolbars Supplied with SymWriter.

SymWriter 2 User Guide

Page 18


../../../../../../Websites/widgit%20program%20help/www/symwriter/html/toolbars/toolbars-supplied.html

Updates

SymWriter will automatically search for updates each time it is launched. When an update has been
discovered, you will be informed at the launcher:

There is an vpdated version of Sy fable. Oick here to downk ‘(.j

— '; e

Communicate: Symwriter

’

A new version of SymWriter is available.

Version: 2.0

Would you like to download the update now?

[ Yes ] [ No ]

Do not ask me again

It is recommended that you update whenever you have the opportunity, as the Widgit Database will also be
updated - ensuring that you have the largest and most up-to-date vocabulary.
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Typical Writing Screen

Users toolbar, chosen from the launcher
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Typical Environment Screen

Users toolbar, chosen from the launcher
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Optional panels for the
Symbol Chooser and Graphics Browser
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the graphic and text are sent to the document
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[ije Symbol
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the word.
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the available vocabulary

Environment Designer Screen

Designer toolbar The side panel has the Grids tab visible in the Designer
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Writing in Symbols

Communicate: SymWriter is a symbol-supported word processor that any writer, regardless of
literacy levels, can use to author documents. Writers of any age or ability can use the Widgit
Symbols to see the meaning of words as they type, supporting access to new and challenging
vocabulary.

So as to start writing, open SymWriter and choose the Write a Document button on the launcher.
You will now be presented with a blank document. Start typing to automatically begin writing in
symbols.

Symbols will appear above the words as you type and ‘smart symbolising’ will analyse the text to
help select the correct symbols.

= SymWiiter - [Untitied 1] e L=
Fle £dit Yiew Feemat Symbols Speech Windows Tecls Help -®lx
S | & Q o B comcsansms * 2 ~/HE B 1 !.l I= ]= smbolare: 24 ~ f) -0
i« BE 90 [EeEEEFEIEFE 49 = ==m[FI[J=E=
21| Symdol | Geaphics

g

N} Pk U Sy

¢
.

s i

£ e

Writing in  symbols |

X + -

Using the Smart Symboliser

Start the program using the Write a Document button on the launcher. Click in the document and
start typing. You will see your text automatically supported by symbols as you type. The symboliser
adds a symbol when a space or return has been typed after a word.

Now on a new line, type “Drink your drink” and watch what happens. As soon as the symboliser has
enough information to detect that the first word is a verb, it will change the symbol to reflect this.

LRV

drink your  drink

Try typing other sentences, such as:
“l suspect the suspect.”

“I can drink a drink from a can.”
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Changing the Symbol from the Symbol Chooser

Due to the diversity of Widgit symbols, you may find that there are multiple symbols for certain
words. Smart Symbolising will endeavour to convey your text in the most accurate way possible,
however; through using the Symbol Chooser, you can select which symbol to use.

Where there is more than one symbol attached to a word, you can choose the most appropriate
symbol from the Symbol Chooser. Or you can press the F9 key to cycle through the alternatives,
including ‘symbol off’. If your intention is to cycle to 'symbol off', you can do this immediately by
holding the Shift key on your keyboard and then pressing F9. You can also turn a symbol off by
clicking on the Symbol off icon in the Symbol Chooser. SymWriter will remember your choice when
you next type the same word in the same document.

Type “I work with computers”.

B SyWriter - [Untitled 2%]
o (X Yon foms Hw

SERE= 2 " I=

o mm B J U Iz Iz

‘:;;z-'sin M W o 4-!»55“'

o ,
A D =
[T é\ R

| workl with computers o (8)

Click in the word “work”.

Click to show the Symbol Chooser.

Click to select the symbol that is most appropriate.
Or click here to turn the symbol off.

PopbE
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Setting the Default Symbol

When using SymWriter you may find that there are common words for which you tend to favour a
specific symbol that is different to the default one. You can use the Symbol Chooser to change the
default symbol or stop symbolisation for a word altogether.

The default symbol for the word ‘drink’ is:

drink

Symbols Geaphics

To change the default symbol, click the right mouse button on your
preferred symbol in the Symbol Chooser and select Set this as the
Default Symbol.

) Pick Up Symbols

iidnnk
Set this as the Default Symbol In this example we have changed the default symbol for ‘drink’ to
the noun form of drink (a drink).
'_%7 \ If you type the verb form (to drink), the smart symboliser will still
choose the correct symbol showing the action for the verb.

Setting the Default Symbol to Stop Symbolisation

Not all symbols are necessary, especially for people who are new to symbols. Abstract concepts like
‘a, ‘the’, ‘if', ‘but’ and ‘so’ can be removed. For readers unfamiliar with symbols, only the main
concepts should be symbolised.

The default symbol for the word ‘the’ is:

B

the

Sometimes, not using abstract symbols such as this one, for example, can help the meaning of a
sentence to become more obvious.

To stop a word from being symbolised, click the right mouse button on the Remove Symbol icon in
the Symbol Chooser and select Set this as the Default Symbol.

When you have set a new default symbol, SymWriter will remember -
your new default symbols every time the program is loaded. _ -

Set this as the Default Symbol
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Changing the Words for a Symbol

You may wish to use an existing symbol, but change the text used below. For example, if you
wanted to write a document about a cat called Felix, you could use the symbol for ‘Cat’ and apply it
to the word “Felix”.

Type “Cat likes tuna”.

Cat likes tuna.

Click on the word “Cat” and either press the F11 key on your keyboard, or click the Change Symbol
cat

L 2
text icon. Sam

[Youaredxangngdwetextformecurentsynbd.PressOkorCan:eltofnsh[ ok || camel ll

_—
—

| | likes tuna.

Type the word “Felix” into green box and either press the right arrow key to move the cursor out of
the green box, press the Enter key or click OK from the dialog box above the symbol.

® O

Felix likes tuna.

Now try typing “Felix is my cat” on a separate line. The word “Felix” is now automatically depicted as
a cat and will continue to be throughout the rest of the document (the symbol for cat will also remain
associated with the word cat).

To save your vocabulary changes see Saving your Wordlist Changes on Page 87.
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Changing the Image for a Word

You may wish to use new images for specific words. For example, you may be writing about
something that you have a photo of. Photos of real people, objects and places can help give a more

specific meaning.

In this example, we are writing about rabbits in the garden. So rather than using the Widgit Symbol
for ‘rabbit’, you may want to use this photo.

Type “There’s a rabbit in my garden”.

Click on the Graphics tab in the right hand panel and you will see the Graphics Browser.

¥ symWiriter - [Untitled 1%] ’7 )
Elo Edt Yow Fomat Jrmbos Sgeech Wndows Tocks Help -8 X
SD=sEI L B uvmm B J U tzlzud DQ - ®Q
LBE OWOEHL EEEELE 4 S = =1 I||EE
=1 Symbols | Graphes
P YO =
There'sa rabbit in my garden. (% @
Geowrsl Meatory
(@) fe=
Home Musxc
[ [
Patterns Pecple
(2
Pecple 2 Fhotos
o [T
il
Prepostiors  Rewards
B B 2
Yo Putires J
( Shared Ptures
‘WidgR Putures

Click on the Widgit Pictures button and then scroll down until you can see the Photos folder. Click
on it to select it and view the contents.

In the photos folder, you will find various digital images. Find the photo of the rabbit and click on it.
When you do this, a transparent thumbnail of that photo will attach itself to the mouse pointer. Hover
the mouse cursor over the rabbit symbol in the document. When a grey border appears around the
rabbit symbol, click again and the symbol will be replaced with the photo.

N
o

There's a rabbit in

(S

lr.. :’.

vty

in my garden.

Once you have made this change, the new image will be
associated with the chosen term for the rest of the
document. The new image will also take precedence over
any other possible symbols, but you can override this
through using the Symbol Chooser.

@

r'abbiﬂ
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Changing the Colours in a Symbol

You may find that you would like to change the colours in a symbol in order to make it as specific as
possible. For example, when making reference to a coloured item of clothing, such as a “green
jumper” (see the example below), you will find that two differently coloured symbols may appear.
Changing the colours in a symbol and editing the associated text can give greater clarity to the

symbol reader.
Type “I bought a soft green jumper.”

You will see that the symbol for “jumper” is red.

T o N

bought a soft green jumper.

Place the cursor in the word “jumper” and then select the Colour Graphic icon from the
toolbar:

In the new dialog box, you can click on specific parts of the symbol in the preview pane to select
which colour to edit. Alternatively, you can click on the colour palette buttons.

© 1 Symbol Patette

ik 0n & colour button to dhange the colowr, oc dck 8
coioured acea of the symbol 19 expand the colour button for
hat colour,

= =

Choose a shade of green and repeat this process for as many of the colours as you like.

T Symbed Patette

Cick 0n & colour button %o change the oo, o dick &
cooured area of the symbol to expand the colour button for
that colour,

EOCana §
mO00EE

cat When you have finished editing the symbol, make sure that the word ‘jumper’ is selected
sam and either press F11 or click the Change Symbol text icon if it is on your toolbar:

Change the word ‘jumper’ to ‘green jumper’ and delete the now superfluous ‘green’ symbol.

ts = A

bought a soft green jumper.
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Qualifiers: Grammatical Markers

A symbol may have a qualifier to indicate whether a symbol is plural, a past tense, a comparative or
superlative.

Plural
Comparative
Past tense
Superlative

j 3 _F ¥
B @

7 - 9

The giraffes were quieter but the lion walked the quietest.

PwbhE

Qualifiers can be switched on or off for either (A) individual symbols, or for (B) the whole document
or Stage.

right click on the symbol and choose the appropriate
menu item to change the visibility of the qualifier.

A — Locally, for Individual Symbols
To turn qualifiers on or off for an individual word, @ '
<

The available options for qualifiers from this menu q Uieterl b Ut the IlO n

are:

e Plural Qualifiers — for adding or removing

plural qualifiers. 8 Soprnimign g
e Tense Qualifiers — for adding or removing B it
tense qualifiers. . ?
¢ ‘Er/Est’ Qualifiers — for adding or removing = A
comparative and superlative qualifiers. - g e e
] showitide Symbols  F10
[P Symbols in Colour /Baw
ﬂ Phural Quakfiers
o] Tense Qualfiers

The small icon next to each option displays a
miniature version of the qualifier graphic that will be
added to or removed from the symbol.

NOTE: This method for adding or removing qualifiers can also be used on selected text.

There are also toolbar buttons for these options on the default full toolbar.
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B — More Generally

(5% Qualifier Settings

=~

Shom Pl dis
++ o Yes
Show Tenses

Yes
9 Don't Change

-

Show Comparatives and Superiatives

" 9 Yes
H-

sove s Oefouts) pestorecefous]  [_oc ][ cancel ]

SymWriter 2 User Guide

Select the Symbols menu and choose Qualifier
Display from the drop down menu.

Using this interface, you can choose which qualifiers
will be visible for any new text in your document.

There are options to show and hide qualifiers. There
will also be an option for ‘Don’t Change’ state, if you
have selected content with mixed state qualifiers for
a part of speech. For example, if you have selected
some content where one past tense verb has the
qualifier turned on and another has it turned off.

NOTE: If you choose to hide all qualifiers, the

method for changing qualifiers described in A
will still work.
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Writing in Text

You can choose to write without symbol support. This can allow users to check the meaning of
words after they have been typed through watching the Symbol Chooser (rather than having a

symbol automatically appear above each typed word). This could be particularly beneficial to a more
confident writer.

This feature can also enable users to identify key words within a document by choosing to have
symbol support for some words (words with symbols of transparent complexity, like: cat, cup, house
etc) and not others (words with symbols of abstract complexity, like: the, a, if etc).

beach
== =
O =13

On holiday I like to go to the beach

Writing in Text Only

Press the F10 key before typing to write text without symbols. This is the shortcut for the text/symbol
button which can turn symbolisation on or off for the selected paragraph or paragraphs.

NOTE: This F10 functionality is different to previous versions of SymWriter.

You can also use the text/ symbol button on the toolbar to change between ‘text only’ and symbol-
supported text.

9 }
=

When the ‘T’ is visible, you are in ‘text only’ mode.

When the symbol is visible, you are in symbol mode.

Using the F10 key or the text/ symbol button will change the selected paragraph or paragraphs to
either 'text only' or symbol-supported text. You can use F9 or the Symbol Chooser to change
between ‘text only’ and symbol-supported text for individual or highlighted words.

When writing in 'text only' mode, there is no space for where symbols would

usually be displayed.

Om O T g

When symbols are tumnedon for selected or highlighted text,

Ky Wik @ W)

the space (and symbol) will appear automatically.
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Seeing the Word Meaning in the Symbol Chooser

Students who do not need full symbol support may benefit from seeing the meanings of words
illustrated either as they write, or later, simply by clicking on a word. The Symbol Chooser can
provide this function.

Make sure you are in ‘text only’ mode and type “Voltage is the electrical “push” trying to send the
current round the circuit”.

S Stk | Gexghis

N P Up Sywbels

Voltahe is the electrical "push" trying to —
send the current round the circuit. o

.

When you click on the word “voltage” you will see a symbol that provides a reminder of the possible
meanings in the panel to the right of the document. This is the Symbol Chooser.

Now try clicking on the word “current” to see the symbols that provide a reminder of the possible
meanings in the Symbol Chooser.

21 Smbols | Graghecs

N o Syt |

Voltage is the electrical "push" trying to e
send the current round the circuit. T

In some cases there will only be one symbol to choose from, however; the Symbol Chooser will
always present you with all possible symbols for any selected word.

NOTE: if you click on a symbol in the Symbol Chooser, that symbol will be inserted into the
document for the selected word.
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Mixing Symbol and Text Writing

You may want to write in text only mode for the majority of the document, but have symbol-support
for some key words.

To do this, you can use F10 or click the text/ symbol button to ensure you are in text only mode.
When you have finished writing, you can click in the individual words that you want to symbolise and
either use F9 or the Symbol Chooser to choose your preferred symbol.

Alternatively, you may want to write using symbol-supported text but not for every word.

To do this, you can use F10 or click the text/ symbol button to ensure that you are writing with
symbol support. When you have finished writing, you can click in the individual words that you do
not want symbolised and either click the Symbol Off icon in the Symbol Chooser, or hold down the
Shift key and press F9 which will also turn the symbol off.

”“"/'.s-*. %9 Q

At the 200 there were lions and penguins.

Putting in Pictures

You can insert any symbol or graphic available to your computer at any time. These pictures can
replace existing symbols in your document, or can be inserted as a separate picture, perhaps to
convey the theme of a paragraph.

P =19 Kkl ER

When I'm at the beach I like to watch the seaq.
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The Graphics Browser

Symbols | Graphics
[ ~\ ~ m
& ®5 [ 4
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Scenes  Transport Underwater

m

My Pctures

Shared Pictures

The Graphics Browser enables you to browse through any
pictures on your hard disk and other network places.

The Graphics Browser is active when the “Graphics” tab
has been selected. The other tab “Symbols” can be used to
change to the Symbol Chooser (Page 31).

E Use this button to move up a directory from the folder
you are currently viewing.

Click once on a directory or folder to see the contents.

Symbols | Graphics |

| — |

Xy N N

angﬂ fish ant anteater badger
B ' - .
=0y e’ \

bat bear bee beetle

To view the images in your Windows My Pictures folder,
click on the My Pictures button at the bottom of the panel.

To view the images in an area that all users can access, click the Shared Pictures button.

To access the supplied Widgit Pictures, click the Widgit Pictures button.

Regardless of wherever you browse to, you can always return to one of these folders by clicking one

of these buttons.

The Graphics Browser example on the right is currently displaying the interface when you click

“Widgit Pictures”.

You can change the default paths for 'My Pictures' and 'Shared Pictures' in Application Settings

(Pagel69).

SymWriter 2 User Guide
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Adding Pictures from the Graphics Browser

You can use the browser to navigate to a picture on your hard disk or other network places for use
in your document.

Select an image that you want to insert into your document by clicking on it once to pick it up.
Position the mouse cursor where you want to put the image.

A grey space will appear where it is possible to insert the chosen image.

[
'_ -
k4 N3 -
- W Bxa Ly %
- We watched the stunning sunset from the porch. F

You can also use this function to replace the symbol for a word in your document, as explained
in Changing the Image of a Word on Page 26.

When you have inserted your image, you can change the way it appears in your document using the
graphic aligning feature described in Graphic Aligning on page 44.

watched the stunning sunset from the porch.
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Adding Pictures from Windows and Web Browsers

As well as using the Graphics Browser to insert images into your document, you can also drag and
drop; and copy and paste compatible images from web browsers and locations on your computer
into SymWriter.

Adding a graphic from Windows Explorer
You can add a graphic from Windows Explorer by:

e Selecting the image in explorer and pressing Ctrl+C. Then clicking in SymWriter and
pressing Ctrl+V.
e You can also drag graphics from Windows Explorer into SymWriter

These actions will attach the thumbnail of the image to your mouse cursor in SymWriter and you will
be able to drop the image where a grey space will appear to indicate that it can be inserted.

O Sypmitnter - Jraned 17
fie (8¢ Yo foomat Hymdol  ‘geach  findows Took Mg

D@ HO ame
Pger = I/ B

S B Oy = Tt i - et e Pot = x- 50

T Frvotey S Pictures library

Adding a graphic from a Web Browser

You can add images from the web to your SymWriter documents. There are two ways to add
images, and depending which browser you are using (e.g. Firefox, Explorer, Chrome) will change
which method works best.

You can add a graphic from the web by either:

e Clicking the right mouse button on the image in your browser and selecting Copy
Image and then clicking in SymWriter and pressing Ctrl+V.
e You can also drag graphics from some browsers into SymWriter.

b ol od riﬁf& S @BEHG DB oncsssus

Open Link in New Jifndow i e e
. B Pu “ =
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Copy Link Locgtion
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Copy Image Locatien

Sape Image As
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>
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Searching the Symbols

You may want to find a symbol to use in a document, either to replace another symbol, or to put as a
separate image in a paragraph.

Click on the Symbol tab on the right hand panel to bring the Symbol Chooser to the front.
At the bottom you will see a search box:

Use the space provided to enter a search term and then either use the Find Symbol button or press
the Return key to search.

—

\s Pick Up Symbols

When you have found the symbol you want, click on it to Pick Up Symbol and click again inside
your document where you want to insert the symbol, as either a replacement or new symbol. A grey
space will appear where it is possible to insert the chosen image.

Sy=ols and Graghes

| Symbols |
i SOHE b Y=

&, Queue at the entrance when you hear the bel. @

Fnd Symbol | school
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Accessing Your Own Pictures

| Symbols | Graphics
- s
Chrysanthe..  Desert

Hydrangeas Jellyfish

Koala Lighthouse

My Pictures

Shared Pictures

Widgit Pictures

SymWriter 2 User Guide

Your pictures will most likely be stored in the My Pictures subfolder
of My Documents. There is a button called My Pictures on the
Graphics Browser which, when clicked, will automatically take you to
that folder in the browser.

You may also want to share pictures with other teachers. If this is the
case, you should use the ‘Shared Pictures’ location to store them, as
this is an area that can be seen and shared by all users of the
machine. This location is within the All Users area of Documents
and Settings. By default, SymWriter will use:

Windows XP file-path:
C:\Documents and Settings\All Users\Documents\Shared Pictures

Windows 7, Vista file-path:
C:\Users\Public\Pictures

If you want to change the location of either of these areas, then you
can do so as described in Application Settings on Page 169.

It is likely that any such changes will need to be discussed with
your network manager or IT technician.
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Text, Symbol and Graphic Formatting

You can change the appearance of symbols and text similarly to most word-processors with various
options ranging from font type, size to colour. The most accessible way to customise the formatting
of these aspects is by using the text, symbol and graphic formatting toolbar.

Arial »|11 '@ B I 1_1 12 12 Symbol size: 10 -~ / _&...;;;"-’

Reminder:

There are a variety of toolbar arrangements supplied with the program to deal with users at different
levels. Not all functions are available on any particular arrangement. In this section we show a range
of toolbar buttons that can be used. It is possible to make your own arrangement of toolbars as
described in the Toolbars Section on Page 58. If you enter the program with the standard interface
on the launcher, then most of the toolbar icons in this section will be available.

Changing Font

The font is most easily changed using the font toolbar. Highlight the section of text that you want to
change and then use the toolbar.

Arial - _
Select a font from this drop down box

i1 ~

Bold

Select a font size from this adjacent drop down box

Font colour

Italics

1=~

Underline

The default and recommended font supplied with SymWriter is the highly accessible FS Me font.
This font has been designed to aid legibility for those with learning disabilities by Fontsmith and
Mencap.

You can find out more about FS Me at:
www.fontsmith.com/projects/portfolio/mencap-fs-me.cfm

NOTE: Although this font comes with SymWriter 2, you will not be able to access it through
other programs unless you purchase alicense.
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Changing the Font Size and Symbol Size Together

The size of the font and symbols can be increased or decreased together. This makes formatting
easier for beginner writers.

T_ Increase the size of font and symbols simultaneously

l-
Decrease the size of font and symbols simultaneously

Changing the Symbol Size

The symbol size can also be set for selected text or at the point where the cursor is by using the
Symbol Size Selector.

Symbol size: 10 ~

Select a symbol size from this drop down box:

NOTE: Symbol sizes are relative to the equivalent text sizes, so a symbol size of 14 is a good
match for text sized at 14.

Switching Between Colour and Monochrome Symbols

All Widgit Symbols can be displayed either in colour or monochrome.

Type a sentence and highlight all or part of it. Press the colour button on the toolbar to toggle
between the symbol colour options: on or off. This function can be applied to selected content, or for
any individual symbol selected by the cursor or mouse.

The elephant hid behind the tree.

B D

The elephant  hid  behind tree.
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Changing the Line Colour of Symbols

The line colour of all Widgit Symbols can be edited much in the same way as the colour for symbols.
This is most useful to assist with visual impairment. When you change the line colour of a symbol
the program will change the symbol to monochrome.

To edit line colour, first select the content that you want to edit and then click on the Format menu
and use the Symbol Line Colour section of the Text and Symbol Formatting dialog.

Symbol Line Colour

[ ]

Choose the colour you would like to set as the line colour and click OK.

] P~
il s = © ik
Queue the entrance when hear he bell.

You may want to change the paper colour to give a good contrast with the symbol line colour. This is
especially useful for enhancing the access to readers with a visual difficulty.

I

A"A‘x._ " O

Queue at the entrance when you hear the bell.

See section Page Setup, Margins and Paper Colour on Page 74 for more information.
Skin Tones

While writing a document, it is likely that a symbol depicting skin tone will appear. You can change
how skin tone is depicted for specific symbols or for the entire document.

Type “the girl is happy” into a document and then press CTRL + A to select everything.

D Now click the skin tone icon on the toolbar.

This will bring up a small box featuring all the possible skin tone options. To change the skin tone,
click on the desired tone.

Skin Tone

000000

The skin tone icon will apply to selected text, or the word or symbol where the cursor is.

%-0 %-0 %-0©

he gil is happy he gil is happy he gil is happy
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Skin Tones for Specific Words

The skin tone icon can be used to affect all symbols depicting skin tone, however; you cannot use
the skin tone button to customise the skin tone for a specific word only.

You may want to customise the skin tone for specific words (like names for example), especially if
you are referring to different people throughout your document and want an easy way of staying
consistent.

Type the word that you want a specific skin tone for.

J

James

@ Now click the Edit the Symbol Colours icon on the toolbar.

Click the colour that currently represents the skin tone in the symbol.

Chck on 3 colour button to change the colowr, o chck 3 mnaa ¢ ohou, ok
coloured aren of the symbel to expuand B colur Button for el el e T et

. colocred ares of the syl 19 expand e colour Button for
thet colour,

that colour.,

NIEEEEEEEN
.
EOENENNEEEC)
ODEEEEEEEC
OoopoEeEcooo|
mOm 1

$Syerioc Pt Symbol Palette l
|

More Coloss..., {

The column on the far right of the grid of colours contains the same colours offered from the skin
tone icon.

Click the colour you want and click OK.

J

James

This word will now have this skin tone every time you use it in this document even if you change the
skin tone using the skin tone icon.

If you want to use these skin tone settings for another document, you can choose Save Wordlist
Changes... from the Symbols menu where you can review your customisations and save them as a
new wordlist that can be loaded in other documents. For more information see Saving Wordlist
Changes on Page 87.
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Formatting Properties Dialogue

You can manage and edit the appearance of text and symbols in your document collectively.

To do this, click on the Format menu and select Text and Symbol Formatting. Changing the
properties from this dialog will affect any selected content, or you can set up your preferences for
new documents by setting a new default.

N

B Text & Symbol Fepmatting

C I

O . O interesting | E O

| Cone |

Select the skin tone by clicking the colour you want.

In this panel you can select whether you want symbols to be displayed or not. Click the
checkbox to toggle between symbols being on or off. If you choose to display symbols, you
can also select whether you want symbols to be in colour or monochrome.

Select what font you want to use for your document from the list. If you already know the
name of the font, you can begin typing and the results will be filtered as you type.

Select what font style and colour you want to use in your document.

This panel allows you to change both the size of the text and symbols in your document.
When the “Link” button is selected, the symbol size will be locked and will automatically
adjust to match the size of the text. If you deselect the ‘Link’ button you will be able to alter
the text size and symbol size separately.

Select the line colour of symbols.

NOTE: changing the line colour will change the symbols to monochrome.

This panel will display a compact example of how your document will appear, based on the
settings that you have chosen.

Select this button to set the new default text and symbol formatting settings, based on your
adjustments, for SymWriter.

Select this button to restore the original default text and symbol formatting settings.

SymWriter 2 User Guide Page 42



Using the Format Painter in the Document

The Format Painter is a feature that can be used to copy text and symbol formatting properties, and
apply those exact properties to selections made in your document.

The Format Painter buttons can be found on the toolbar:

To copy formatting, click

To paste formatting, click =

If you have made a document and want to match the formatting of some, but not all of the content,
this tool may be of particular use. For example, you may have a section in your document where you
want to modify certain aspects, such as text colour and size, so that they match other sentences —in
this case, the Format Painter can quickly make these changes without requiring you to go through
any dialog boxes.

This can be beneficial for ensuring the identical formatting of section headings.

To do this, you can highlight or click in a section of text that you want to copy the formatting
properties from:

Holiday
A
-M A
Hhcn am on holiday, | e 1oge to the beach.

P

=l
enjoy sunbathing and swimming.

St =4

When I'm at the beach,

Now click the Copy Formatting button:

Ve

- Highlight the text that you want to apply the copied formatting properties to and click
the Paste Formatting button.

Holiday
=\ —
When am on holiday, I like togo to the beach.
When I'm .at the beoch enjoy sunbcfhing and swimming]
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Text Aligning

Text in paragraphs can be aligned left, centre or right using the standard icons or from
the Paragraph dialog from the Format menu.

Indents

To insert a paragraph indent, or increase the size of an existing indent, click on the button featuring
the right arrow. To decrease the size of an indent, click on the button featuring the left arrow. These
can also be set from the Paragraph dialog found in the Format menu.

e

Bullet Points
To apply bullets to any paragraph (or selected set of paragraphs), simply click the Bullet Icon to

switch the bullets on and off. You can also set this in the Paragraph dialog from the Format menu.

Graphic Aligning

When you have inserted a graphic into your document, you can choose how you would like it to be
aligned. To view the possible alignment options, right click on the graphic and select the word
“Align”. From here you will be able to select one of the three following options: “Left”, “Centre” or
“Right”.

These options are also available on the toolbar in the form of three separate buttons.

= =

To edit the settings of graphics in your document in a more specific way, select Graphics In
Documents from the Format menu.

= Graphics Settings =5
In this dialog box, you can choose how text should e
be displayed in relation to the inserted graphic. This
could be a particularly important feature if you are
inserting graphics into a document with a lot of text.
For example: you may insert a graphic with the
alignment set to “Left” which could in turn disrupt the e A
layout of the existing text. To change the “Text
Flow”, select the graphic with the right

mouse button and select one of the options from
“Text Flow”: wrap text to the “Left”, “Right” or to the

“Largest” space.

I
A
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Changing the Graphic Size

Graphics that are dropped into the document as illustrations have their own default height setting.
When a graphic has been inserted, the graphic will be displayed at this default size. You can change
the size of the graphic using the directional buttons on the border. To adjust the size, click and hold
the arrow that represents how you want to change the image and then drag the mouse to resize:

the right-hand side button will allow you to change the width,
the button directly underneath will allow you to change the height

and the button in the corner will allow you to change the width and height at the same
time while maintaining the aspect ratio of the graphic.

Aspect Ratio

If you stretch a graphic out of proportion, you can sert the aspect ration by
= simply double-clinking on it.

Rign » | Reset Size

Text Flow ’ If you want to revert to the previous default size, simply select
the graphic with the right mouse button and select Reset

Reset Graphic Size Graphic Size.

Make this the Default Graphic Size

X Delete this graphic

align R Default Size

Text Flow ’ You can also choose to make your newly resized graphic the

default graphic size for all future graphics inserted into the

Reset Graphic Size document. To do this, select your graphic with the right_ _
mouse button and select Make this the Default Graphic Size.

Make this the Default Graphic Size

XK Delete this graphic
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Specific Sizes

If you want a precise measurement for the height of a graphic, you can configure this from the
Graphics Settings dialog by choosing Graphics In Documents... from the Format menu.

You can use the arrows in the spin-box or enter a new measurement in the Graphic Height section
to adjust your graphic in real-time.

Graphic Height
Spedfy the height of selected graphics: 69.99mm '+
Margn and Padding
Spedify the margin between graphics and text: 2.00mm S
Specify the padding between multiple graphics: 0.50mm ¢
(save as Defauits| |Restore Defauits| [ ok [ cancet |
Tabs

In word processing, a tab is the movement your cursor makes from one position to another when
you press the tab key on your keyboard.

To adjust the settings for tabs in SymWriter, choose the Format menu and then select Spacing
and Tabs.

>

=== Alternatively, you can select the Spacing and Tabs button on the toolbar.

To set the possible amount of equal tab settings across the page, either enter a number between 1 -
8 or use the arrows.

" Leading and Tabs =

Tabs

Number of Tab Columns Across The Page: 5

E—ee——-

You can also choose to save your changes as the new default settings, or restore the original
default settings.

[Save as Defaults] [Reshore Defaults]
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Spacing
You can choose to alter the horizontal spacing between words or symbols. You can also alter the
spacing between lines, and add extra space between paragraphs.

To edit spacing, select the Format menu and choose Spacing and Tabs.

e

=== Alternatively, you can select the Spacing and Tabs button on the toolbar.

As you make changes in this dialog box you will see the effects of these changes immediately on
selected text.

Spacng Character Spacing
Horizontal Spadng: 3mm Spacng Between Letters: 100%
Line Spacng: 100%

Extra Space Between Paragraphs: 3 mm

[Save as Defauits| (Restore Defauits| o ][ coxe

You can also choose to save your changes as the new default settings, or restore the original
default settings.

Horizontal spacing affects the space between words.
o |

Q
A2

| <€—> |ike <€—> the <—>beach.

Line spacing affects the space between wrapping lines.

=1 %

It is my favourite place

|
iy

when it is sunny
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Extra space between paragraphs affects the amount of space between paragraphs.

iy C0Y
= K

when it is sunny.

‘i@ kel

like to watch the surfers.

\r,

Spacing between letters affects the amount of space between individual letters.

===
P
“«—>
ac

b e h

Graphic Spacing
You can choose to alter the spacing between graphics and text. You can also alter the spacing
between multiple graphics.

To edit the spacing, select Graphics In Documents... from the Format menu. Use the arrows on
the spin box to produce the desired change for the option that you want to alter.

Margn and Padding
Spedify the margin between graphics and text: 2.00mm %
Spedify the padding between multiple graphics: 0.50mm &
save asDefoults| [RestoreDefouits] [ ok | [ concel |
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Spacing between graphics and text

When you modify the content of the spin box for Specify the margin between graphics and text,
you will be affecting the distance between a graphic and the text next to it.

As you make changes to the spin box you will see the results of these changes immediately.

Specify the margin between araphics and text: 2.00mm 5 |
o
—
When I am on holiday, I

O & =

like togo to the beach]

Spacing between multiple graphics

When you modify the content of the spin box for Specify the padding between multiple graphics,
you will be affecting the distance between two graphics.

As you make changes to the spin box you will see the results of these changes immediately.

|
Ot =1
When I

am on holiday, I

Specify the padding between multiple araphics: 0 50mm

[«[%]|

O# =

like togo to the beach.

You can choose to set your alterations as default settings using the Save as Defaults button. If you
want to return to the previous default settings, choose Restore Defaults. To accept your changes,
click OK.
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Text on Top

In your document, you can choose whether you would like to see text above or below symbols. To
choose, click the Format menu and then select Text on Top.

You will then be presented with the following dialog box where you can choose how to display text in
relation to symbols and set or restore default settings.

= Configure Text on Top

W W Text Above Symbols

(Save as Defauit] [Restore Defauit]

5 3l

o MEN . .\ e symbols

[

oK

) [ conce

Text above symbols:

| like the beach.

1 @

Text below symbols:

10 =

| like the beach.

ii;%

|
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Copying Symbols into Other Programs

You can copy symbolised content from SymWriter and paste into other programs such as Word and
Power Point. This can be useful if you want to use your favourite symbols, or take symbolised
content that you're happy with for use outside SymWriter.

For example, you might be creating a Power Point presentation for a particular audience that could
be enhanced with the use of symbols. Instead of using other programs (such as an image editor) to
capture your symbols in SymWriter, you can simply use the Copy As Image function.

To copy an image from SymWriter for use in another program, click inside the associated word or
image that you want to copy and either: choose Copy As Image from the Edit menu, click the right
mouse button and choose Copy As Image or press Ctrl+Alt+C.

% Or you can press the Copy as Image button on the toolbar.

If you are copying an image that has been symbolised from text, the associated word will be
included in the copied image.

=
-
My Holida |

Copy Asimage Qe An=C
Pacre Q¥

L B

Adgrement ’
Bty

Spesk Th Sertence

DrowHide Symboly 1o
Symibols in Colcot/BAW

Phoral Qualfiers

Terae Qualfiers

Tl Quaidien

i fs[@lI)e i

Then in another program such as Word or Power point, press Ctrl+V to paste the symbol content as
an image.

; '%’JJTI v

wene | Wmad  Deuge  Aemstom B Rres Vew  Ases -

(VI - Y

al 3 e »
= ) e ; o0
ey e B UL AR EBaBD Sapr Awrge

Holiday Pr._esentfations
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Copying a Grid into Other Programs

You can copy aspects of Environments, as well as symbolised content from a document, such as:
Grids, Trays, Buttons and Text Boxes; for use in other programs like Word and Power Point. This
can be useful if you want to use symbolised content in such forms as a grid for example. You could
use this function to make vocabulary cards by taking a Grid from SymWriter, copying the image to
Word and then printing.

To copy a Grid as an image from SymWriter for use in another program, make sure you are in

Design Mode and select the Grid in Object Mode and either: choose Copy As Image from
the Edit menu, click the right mouse button and choose Copy As Image or press Ctrl+Alt+C.

[% Or you can press the Copy as Image button on the toolbar.

L I -] n00
el L IO s

Then in another program such as Word or Power point, press Ctrl+V to paste the symbol content as
an image.
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View Options

There are a variety of different ways to change the way you can view your document and how your
document will appear. These options are available from the View menu. You can use these options
to optimise how you produce documents.

You can also modify any of the toolbars currently accessible and create new ones regardless of
whatever level of interface you have chosen.

Page Layouts

There are three ways to display the pages in a document.

To choose your layout, select the ‘View’ menu and then ‘Page Layout’.

VEU Format  Symbols  Speech  Windows  Tools  Help

| Page Layout ’ Page Break View
Zoom Y 1177 Print view
Page Options...

Continuous Yiew

—

CREI RO - et "he0
> Tie

Lmy N BEaRawar A S *y

Page Break View

Shows the pages vertically under one another with & (<3 17 & o \&
a clear division between them. AR BEERRIARIEN ARL. S

Ankis in the Greck rome for o pohal-hooded god cmecstod with
- rummiicston ond we afterhfe » Egyptan mythcligy, In the croont
N’ Eqrotam lonpagt, Anses i baows o0 Tage The olden s rentin of
Ands 1w o the 06 Konpiem pyrimvd Tty abere M os satO0 ol with B Bl of e
ing AN the Neme, Andbis mes The mert bepeetont 408 of the Deod but be wes reploced
doneg e Mdde Grpiom by Osne

e Sohcs romes A comvac bon wnth g funorory rele, schon e el ix gpon Ay meundan,

SRk s nnnis s mmsstanis as a asstactan sl Vhs Hirsssad sk Whsn Sambi sad tha

Print View

Shows one page at a time. To navigate the
document, pages need to be ‘turned’ forwards and
backwards.
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Continuous View
The document is seen as one long document & et &1y @0 X

X A god  of P dwd He  led  The deed Peosh derbnes
without breaks. o

Ankis s the freck rome for ¢ jochal beodod god emottod mith

memiceton and the efterlife m Egypton mytralogy I the ancomt
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Zooming

Choose the level of zoom that suits your document.

Select the ‘View’ menu and then ‘Zoom’.

Fit to width ensures that the width of the document fills the available space.
Fit to space makes a page size fit entirely.

VCUN Format Symbols  Speech 7Windows Tools He

Page Layout L4 [ 7

Zoom & 200% Width

Page Options... 150% Width

Page Mavigation ’ i Fit to Width

75% Width

*# Toolbar and Launcher Options... 50% Width
Symbol Chooser L LD Fit to Space
Graphics Browser

Show Double Panel

Side Panel Item Sizes

Select Page Options to customise the zoom options to your preference and save or restore
defaults.

ﬂ‘ ﬁage:bbtidns '
Page Layout Zoom Level
@ || Page Break View () 200% Width
® [T] Print View ':' 150% Width
(7) | | Continuous View © £ FitTo Width
() 75% Width
) 50% Width
> L1l Fit To Space

@) Custom |100% Width 2]

Save as Default} [Restnre Default] [ oK ] [ Cancel ]
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Page Navigation

Navigating Page Break and Continuous Views

If you are in Page Break or Continuous page layouts you can scroll up and down your document
using the scroll bar at the side, or with your mouse wheel.

_ Page 2 .
You can also us the Go To Page option on the toolbar:

Navigating Print View

If you are in Print View page layout, the Go to Page option on the tool bar will
have Back and Next buttons available:

LL—_ Page 2 - ‘I

You can also navigate the pages in your document choose the View menu and then Page
Navigation.

VU Format  Symbols  Speech Windows  Tools  Help

Page Layout 4

Zoom »

Page Options... ’ :‘ e ‘
‘ Page Navigation ¥ |

“# Toolbar and Launcher Options. .. \
‘ | =) Next Page

I:’ Symbol Chooser _I Last Page

: Graphics Browser

Show Double Panel

—] | ] |

Side Panel Item Sizes
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Side Panels

To the right of your document is a panel that can be used as the Symbol Chooser (Page
23) and Graphics Browser (Page 33).

You can choose what is visible in this panel by using the View menu. Select Symbol
Chooser or Graphics Browser to show or hide the panel. When the panel is selected, a border will
appear around the corresponding icon.

You will see a tab for whatever has been selected in the right hand panel.

If you select Show Double Panel, a tick will appear next to the option in the View menu.
When Show Double Panel is selected, the right hand panel will feature one tab for Symbols and
Graphics, and the space beneath will be divided equally for each.

Graphics Panel Symbols Panel Double panels
Symtols Gaghas Symeas Gaptwes Symbols and Graghay
N Pk Symbols L Symbols |
— “N) Pekup Symbols

: . bop - = e L
By dme =2 @L @ [
ngdifuh srteater ' . \ :" ’,_ -
- S Y

e Ne Ne =

Badger bat bess .

Caln '

bee beetle ity

£ 9

bod blackbed bl
busye

v ':.l" dﬂ'f- Frd Symboi

w::", bhuefly  beschions | Graphics |
. L

e @ <

e Y e '@ e s

ﬂ % ";, ngdfan seneater
y . ) -

7\;" Badger kb: 5

f{ th - _ :

camel - cu:wl.‘ o | tﬁ ‘ @

» -

My Pchres My Pchres
Shared Pt Shared Pt
Wt Ptres Fird $ymbol Wt Ptres
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Side Panel Item Sizes

You can change the size of the items in the Graphics Browser and Symbol Chooser. This can make
it easier to browse large folders of graphics or you are in a very high or low screen resolution.

To edit item sizes, select Side Panel Item Sizes from the View menu.

In the new dialog box, you can user the sliders to change the size of the items in the Symbol
Chooser and Graphics Browser. As you adjust the slider, the box on the right of the slider will
automatically change to reflect the new size. When the box displays “Normal”, this means that the
slider is at the original default item size for SymWriter.

f ———— ———

R £ it Side Panel Rem Szes
Symbol Chooser Item Size
Graphic Browser Item Size
— . :
{Save a3 Defouts| Restore Defauits| o Cancel

You can save your changes as the new default settings for all future documents by using the Save
as Defaults button. If you change the slider settings and want to restore the previous slider settings,
click the Restore Defaults button.

Symbols VG'wNSV $wbok Graphs .

’R-‘ R t"% ‘ _ﬁ angel fish
T YAN <R

bty brd backdd b anteater badger
budge

W ¥ o e 5 o
buefy bachos brown
o = War P
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Toolbars

The availability of buttons on the toolbars is dependent on the interface that was chosen from
the SymWriter launcher.

It is possible for you to edit these toolbars. You can also create interfaces with custom-made
toolbars that can be selected from the launcher.

File Edit View Format Symbols Speech Windows Tools Help

N B 1= ]z & rage 12 o &

fﬂ

Toolbars Supplied with SymWriter

From the launcher dialog, you can select the pre-defined interfaces that come with SymWriter.

There are four standard toolbar sets supplied with the program, two for full access to the program
and two for beginner writers:

Full Toolbars — Access to all the features for document writing.

Design Toolbars — Access to all the features needed for creating an Environment
Environments Toolbars — The basic features needed when running an Environment
Writing toolbars — The basic features needed when writing documents

NS

NOTE: Despite the fact that these toolbars are pre-defined, you can load any interface and
use that specific toolbar to create your own toolbar that can then be saved as a separate
interface.

NOTE: If you have upgraded to SymWriter 2 from Version 1, you will still have access to your
original toolbar sets. You can delete any toolbars that you don’t wish to use from the Toolbar
and Launcher Options

Full Toolbars:

This toolbar features an interface with a comprehensive range of SymWriter functions for writing
documents. These include complete options for symbol control (like setting qualifiers, skin tone, etc)
as well as formatting and spelling settings. This toolbar is recommended for expert users such as
teachers.

| file fde \wew Format Smbols Sgeech Windows Jools  Help

5 _dg;j\'-'\. Page 1
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Design Toolbars:

This user interface is not selectable from the launcher in the same way as the others. It is
automatically selected when you ‘Design An Environment'. This toolbar set contains most of the Full
Toolbars interface and has more options for designing Environments (like buttons for creating
Stages, Trays and Grids). This toolbar is recommended for expert users such as teachers.

NOTE: You can choose to hide the Design An Environment interface by using
the Launcher menu at the launcher and deselecting the option Show the Designer Button.

b e[St Yoow foemst §ymbok Sgeech Emiropment Windows Jools  Help
G L L T
Aral cw <lr T B

% Environment Toolbars:

This toolbar features the most basic level of interface. This toolbar has been designed in such a way
to aid a user who wishes to simply author a document using an Environment. This toolbar could be
useful for a switch user or a user who is not confident with writing.

C e - . D o [ ] F & i
U srease 0 - v Iw [(H2 @9 (0] %20 IR

'I'I'I
llllll
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g File Edit View Format Symbols Speech Windows Tools Help

A0 B 12 = [ rage 1 ¢ B

Using this toolbar you can:

. Return to the launcher

. Start a new document

. Open a document

. Open an environment

. Save the document

. Increase the size of text and symbols
. Decrease the size of text and symbols
. Turn symbols on or off

. Navigate the pages of the document
. Use verbal feedback

. Perform a quick edit

SymWriter 2 User Guide Page 59



Writing Toolbars:

This toolbar features a more varied interface that can support a user who wants to author a
document with or without an Environment.

| fle £t Yew Formst  Symbol  Sgeech Windows Jools Help

@B Hd I m -mBIzlz:[EP o EEEEEE G L6

Using this toolbar you can:

. Return to the launcher

. Start a new document

. Open a document

. Open an environment

. Save the document

. Print the document

. Choose a font

. Choose a font colour

. Choose to make text bold

. Increase the size of text and symbols
. Decrease the size of text and symbols
. Turn symbols on or off

. Edit symbol colours

. Navigate the pages of the document
. Align paragraph left

. Align paragraph centre

. Align graphic left

. Align graphic centre

. Use verbal feedback

. Check Spelling

. Perform a quick edit if you are using an Environment.
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Editing Toolbars

You can modify any of the toolbars and create new ones regardless of whatever level of interface
you have chosen.

To view the set-up of your existing toolbars, select Toolbar and Launcher Options... from
the View menu. You then now be presented with the following interface.

&Ymuumo;mm = |
Toobwrs Avalable Buttors Current Toobar Butiors
B ¢ 3] < SEPARATCR > A =] Return to Launcher
R Ac«;vbs-rﬂy g New Document
chis £ ; OpenD .
Formatting *® Switch Opticns... G Save eemen
Symbols Abgn Geaphacs & Print...
Quaifiers M. Centre
Page Navigation ¥ et
Copy and Paste “
Ahgament Right
Bullets and Tabs Apptarance s
Text Selection Eda Gnd Appearance L )
Speak Ednt Tray Appearance L3¢
| Spelling % Eda Tray Content Appeara... Brizsne
Switch Access Bullets et
Mede Change = Bullets il
Undo and Redo Clpboard
Dy Copy
= Copy Aslmage
W Cnt
B Paste
Design Mode
© Design Mode
© Exit Design Mode
& Quick Edit
Emvironment s
‘ Butwn Sze
} Apgly to:
| Edit Louncher | O Altoobers
G seected tookr
[see ][ coe
Toolbars
Toolbars (left panel) 7 X 5
71N . .
This panel contains a list of all the toolbars that are present in your '
document. You can select one from the list to modify it using the Main
following panels. Copy paste
Formatting

When a toolbar has been selected you will see a red square envelope that specific toolbar.

90w aa[= - B ] U= 1= seewe - 2 | =) [09 (0] %=
Pge1 2 n: E i = BEE 9 LB 2 NWO 2

S

i
il

|

This panel also contains the three following buttons and accompanying functions
Create a new Toolbar
@ Delete the selected Toolbar

Rename the selected Toolbar
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Available Buttons (centre panel)

This panel contains a list of all the buttons that are available

Available Buttons -~ ] a
to add to your toolbars, divided into categories.

| < SEPARATOR > N
Accessibility . The only feature in this list that isn’t categorised and isn’t
® Switch Is Off = actually a button is
* Switch Options... ‘< SEPARATOR >’. The ‘< SEPA_RATQR >'is u§ed tp
Align Graphics separate buttons on_a_toolt_)ar by msertw_mg_ a vertlcz_il line. In
®_ Centre the example below, it is being used to divide certain
et formatting buttons on the formatting toolbar.
Left
= Right To add a button to your selected toolbar, use the red
Appeasance horizontal arrow button:
' Edit Grid Appearance -
Edit Tray Appearance I = |

Current Toolbar Buttons (right panel)
This panel contains a list of all the buttons that are active on the selected toolbar.

You can use the following buttons to modify this toolbar

L Delete button

IL| Move button up a place in list

I_L| Move button down a place in list

When you move a button using the vertical arrows, you will change the position of that button in the
selected toolbar. The red arrow pointing up will move the selected button one place to the left on the

toolbar. The red arrow pointing down will move the selected button one place to the right on the
toolbar.
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New Toolbar Example

With Toolbar Options, you could set up a new toolbar specifically for parts of speech:

@ Use the ‘create a new Toolbar’ button from the Toolbars panel and name it ‘Parts of Speech’.

Qualifiers
Select
| Parts of Speech |

Now find the Parts of Speech section in the Available Buttons panel and add the buttons to your
new toolbar.

Available Buttons Current Toolbar Buttons
Parts Of Speech e Nouns
Nouns Remove Marks
Remove Marks Verbs
Verbs

You can now change the order of these buttons on your toolbar. You may want to move ‘Remove
Marks’ to the last position to make your new toolbar more user-friendly. Use these arrow buttons to
move each button selection up or down.

Symbol size: 14 ~ L: j = 9
HI- E=
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Toolbar Button Sizes

To edit the sizes of the buttons on your toolbars, select Toolbar and Launcher Options... from
the View menu.

Use the radio buttons to select the toolbar that you want to apply the sizing modification to. If you
select All toolbars, all of the buttons on your toolbars will be affected. If you select Selected
toolbar, only the buttons on the toolbar selected in the Toolbars panel will be affected.

Button Size

|:| Apply to:

All toolbars

@ Selected toolbar

As you move the slider on the sizing scale, the buttons on the selected toolbar or all toolbars will
change to reflect the change immediately.

If you have a toolbar that is of particular importance, you may want to change the button size for that
exact toolbar.

If you have made any changes, when you click Save you will be taken to a dialog box where you
can set up a new user interface with your new toolbar preferences.

Click Cancel to return to the document and discard all changes.
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Saving Toolbars

When you have finished making changes, you can click the Save or Save as button to save your
changes. These changes will be saved to a new user interface that you can set up in the following
dialog box:

™ Edit Interface

Tom's Toolbars

Button Text: Tom's Toolbars

Button Picture: |C:/Users/fredd/Pictures/tom.jpg D

["] Load an Environment File Automatically

Environment File

[] Enable Switching Save Switch Settings

Using this dialog box, you can name and choose a picture for a new user interface for SymWriter
that will feature the saved changes made to the toolbar options.

Enter a name for the new user interface in the space next to Button Text.

To select a picture for the new user interface, either click the current picture or click the grey box
next to the file-path space next to Button Picture.

Automatically open with an Environment

If you want the new user interface to be exclusive to a specific Environment, click the check box next
to Load an Environment File Automatically. You can then select an Environment by clicking the
grey box next to the file-path space.

Automatically Enable Switching

You can also choose to Enable Switching by clicking in the adjacent check box. By selecting this
check box you will automatically enable switch access every time this interface is selected. To save
your current Switch settings to the interface, you can select the check box next to Save Switch
Settings.

After you have clicked OK, you will be able to select this new interface from the launcher.

NOTE: If you have selected to Load an Environment File Automatically with the new interface,
you will only have the option to open the specified Environment from the launcher.
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Copying, Deleting and Sorting Toolbars

You can manage your Custom Interfaces through using the Edit Launcher button
from the bottom left corner of the Toolbars and Launcher Options dialog. In the
following dialog you will see all of your Custom Interfaces.

Configure Your Custom Interfaces

Tom's Toolbars Roryteling
Toolbars

(5 Losd seiected SmeOnenlAsNew {\j Copy Seiactad @ * Qso: Xweee

Copy

To copy an interface, select an interface with the left mouse button and choose the Copy
Selected button. This will take you to a similar dialog to Edit Interface that you can use to change
the name and picture of the interface. You can also change the copied interface to automatically
load an Environment file and/or enable switching. This could be useful for a user who has an
optimised toolbar set up and wants to apply the same toolbar settings across multiple interfaces
configured to automatically load Environments.

x Delete

To delete an interface, select the interface that you want to remove with the left mouse button and
then click on the Delete button. When you do this, you will be prompted with a warning message to
make sure you want to continue with your selected action.

11213
415
719

Sorting

The sorting of interfaces refers to the order in which your interfaces will appear when you are
choosing one from the launcher. To move an interface, select the interface that you want to move
and use either the Left or Right arrow buttons. To automatically arrange the interfaces by alphabet,
click the Sort button.

ala
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Desktop Shortcuts

You can choose to launch SymWriter with a pre-defined interface from your Desktop if you wish.

Ll

Edit Launcher

To set up a Desktop Shortcut, select Edit Launcher from the Toolbar and Launcher
Options dialog.

In the following Dialog, you will be able to manage all of your custom interfaces.

[ B
o

(6 Lnunchar
Configure Your Custom Beterfaces
oy oy
Cuve
—

To create a Desktop Shortcut for your interface, first select that interface with the left mouse button
and then click the Create a Desktop Shortcut button.

You will now have a Shortcut to SymWriter on your Desktop with the same name as your selected
user interface.

NOTE: If you have chosen to load an Environment automatically with this user interface,
when you launch it, you will immediately be presented with that Environment and skip the
launcher.
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Opening, Saving and Printing Documents

This section concerns the ways in which you can open, save and print documents. For information
about Environments see Saving Environments and Opening Environments to Edit.

It is recommended that you save your work on a regular basis, and additionally it may be beneficial
for certain users to keep a physical copy of some documents.

You can also save and open documents directly from SymWriter Online, and enable auto save to
ensure you do not lose your work.

Opening Documents

To open a document, simply select Open Document from the File menu, or click on
] the Open a previously saved document icon on the toolbar.

From here you can navigate to the file that you wish to open. The default path for opening
SymWriter documents is:

Windows XP
C:\Documents and Settings\%username%\My Documents\Widgit\SymWriter

Windows 7
C:\Users\%username%\Documents\Widgit\SymWriter
- %username% is a variable that Windows will substitute.

—

anecuﬂeloopm '
— —
CU () « Documents » Widgit » SymWiites = [ 43 W seorcs 2
‘ Organize v 543 Views v . Neéw Folder
Neme Date modified Type Size Tags
Documentation Bonums
- Deskton Rconle{h
: [ egyptian sentences
Recent Places .
e [ fioat and sink
8 Computer B hokdey
n" Documents Elllketo
B Pictuces [ sightseeing
B Music [™ weather
) Recently Changed
E’ Searches
& Publc
Folders A
Flo name:  Egyptian Hatory - ‘Swwrt«WmDowm x4
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Opening Documents into Environments

If you are using an Environment, you can load a document directly into the Environment. This can
be useful if you have been using a complex Environment and saved your document so you could
continue at a later time.

T Vo s ¢

0 e p— g — oy

13w

I MBI URR e -SRI O =
~ LA 1k LY B BS « ~“PE*NOD

— -

— = @ 1

Egwt 5 n nobesst Avica

g

4

&

are called priests.

are called pharaohs.

If you want to open a document without an Environment, you will have to go back to the launcher
and select Write A Document. You can then open a document using one of the methods described
above.

T b s il ——

A g e g g—

B ey B U e HiNse o =T
~- nAES3 "?_' §S ~“BE=N9
— [r )
— = 1
Egwt 5 n nobesst ANrca 1
— R %
- *
Egypt 5 2ot by e mesNie
L~ { |
> * &

< m 3

Te sphimw & 2 hupe  stshe
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Opening SymWriter Online Documents
If you have a SymWriter Online account, you can open your online documents directly into
SymWriter.

NOTE: You need to set up your SymWriter Online account settings in SymWriter 2 to access
your documents. See Application Settings

To open a SymWriter Online document to go the File menu, then select Open SymWriter Online
Document.

You will then see a list of all your online documents. Select the file you wish to open, then
click Open.

Crr—— =
Name Author Croated Modified r
Anubis Egyptian Mythology James Barber 31/10/2012 31/10/2012
‘ Rhyming Words Jarmes Bacber  29/10/2012 30/10/2012
Healthy Eating James Barber 29/10/2012 29/10/2012
Greek Mythology James Barber  29/10/2012 29/10/2012
.'“\"5 Rivers & Coasts James Bacber 29/10/2012 29/10/2012
‘ Usirg Dernocracy James Barber 29/10/2012 2971042012
B viking Sagas James Barber  29/10/2012 31/10/2012 -
Canct

Saving Documents

From here you can navigate to where you wish to save your document. The default path for
E saving SymWriter documents is:

Windows XP
C:\Documents and Settings\%username%\My Documents\Widgit\SymWriter

Windows 7
C:\Users\%username%\Documents\Widgit\SymWriter
- %username% is a variable that

Windows will substitute. T < lect 2 save flename
{ )u | 1. « Documents » Widgit » SymWiiter v | 49 || searon L
\ Organize v 643 Views « ' New Folder
Once your document is saved, SERTR ST Datemodified  Type Size Tags
selecting save again will save over B i [ anubis
your file. If you wish to make a B8 Dedor BB confett
separate copy of your document 3 Recent Places %m’::’;‘::’““
with a different name, select M Computer Plhekidey
Save As. E Documents R ike to
‘ Pictures B;.gmwgq
NOTE: It is important to save B Music (B weather
your work on aregular basis. I Rackolly Chsapnd
Mote »
Folders A
File name: i =
Save 25 type: | SymiWriter Writing Documents (.swdoc) =
e Foktes (oo ] [ Concs |
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Saving Documents to SymWriter Online

If you have a SymWriter Online account, you can save your documents directly to SymWriter Online.

NOTE: You need to set up your SymWriter Online account settings in SymWriter 2 to use this
feature. See Application Settings

To save a document to SymWriter Online, go to the File menu and select Save Document to
SymWriter Online.

You will then see a list of all your online documents. Give your document a name in the Document
Name field and click Save.

Name Author Created Modified °
| Anubis Egyptian Mythology James Barber 3171042012 31/10/2012
‘ Rhyyming Words Jarmes Barber  29/10/2012 301072012 :
-.l.‘ Heafthy Eating James Barber  29/10/2012 297102012
: Greek Mythology James Barber  29/10/2012 29/10/2012
i Rivers & Coasts James Bacber 29/10/2012 29/10/2012
| ‘ Using Dernocracy James Barber  29/10/2012 29/10/2012
Document Name: Float & Sink
(ET -

When you have saved your document, you will be able to access your document through SymWriter
Online or by opening documents from SymWriter Online through the SymWriter application.
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Auto Save

You can choose to enable auto save for your documents and Environments. With auto save, if the
program or your computer crashes unexpectedly, you can recover your work when you next load
SymWriter.

Enabling Auto Save

To configure your auto save settings, click the Tools menu, then select Settings and choose
the System tab.

Auto Save

Auto save periodically saves a copy of your
current document in the temporary directory in
case anything goes wrong with your computer
or the software while you are working.

Enable Auto Save Every

When auto save has been enabled, whatever you are working on in SymWriter will be subject to the
time period specified in the drop-down box.

Document Recovery

Should anything go wrong with your SymTte hes detecind an s sesn Dot s Can rocver 04 Con eer (TS 4 o Gt D fies

computer while you are working, the
next time you run SymWriter you will
be presented with a message at the
launcher where you can choose
whether you want to recover your
last session or delete it.

If you do not choose to recover your
last session, it will be deleted
permanently. If you choose to
recover your last session, it will be
loaded. You should then use Save
As to save this restored work with a
new name.
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SymWriter File Compatibility

While you are using SymWriter 2, you will be able to open Documents from previous versions of

SymWriter.

However, you will NOT be able to open Documents saved in SymWriter 2 using previous versions of

SymWriter.

If you try to open an Environment saved in SymWriter 2 using a previous version of SymWriter, you

will be presented with the following document:

ol el R
HOwlds EE -

20 & @ [E -2

This file was created in SymWriter 2

M A da [E

You need to update SymWiter to open it

Bl - &

The update is Free,

puB/us cMavEFIR oS

Visit: downloads.widgitcom |

—_—

If you are using a previous version of SymWriter, you are entitled to a FREE update to SymWriter 2.
To obtain the update, follow the instructions and go to downloads.widgit.com.

Printing

3

% Prnt ]
Genenal I
Select Printer

% Add Printer i CutePDF Writer
@MAdobePOF ______ SFx
(& Canon iR-ADV C5030/5035 UFR Tl on ryu_ 18 HP Laseret 1100 (MS) or

‘ m ’

[T Prrttofie Preferonces

Fing Printer,

Number of gopies: |I 52

SymWriter 2 User Guide

To print your document, go to the File menu and select Print... or select the print icon from
the toolbar. When you choose to print, you will see the following dialog box:

From here you can choose which printer you
want to use, how many copies you want to
print and you can adjust your printing
preferences.

The options for setting printer preferences
will be dependent on your type of printer.

If you have chosen to view your document

as a continuous layout and want to see the
page breaks, select Page Break

View from Page Layout in the View menu.
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Page Setup, Margins and Paper Colour
To ensure that your document is set up in the most efficient way, you can choose Page Setup from
the File menu to configure the settings.

Any changes you make to these settings will be reflected in your SymWriter document, as well as
the printed version.

-
" Page Setup 5]

Paper Size Margins

© Standard A4 (210m x 29.7cm) 2 1.00 |3 om

Custom

Size

Width: |21.00 < am 1.00 5 am 1.00 5 om

Orientation

@ Portrait Landscape 140 [3] om

Paper colour

Cick to change paper colour “i”

(Save as Defaults| [Restore Defauis| [ ok ][ conce |

Paper Size

When the Standard radio button is selected, you have a choice of predefined dimensions for
standard sizes from the drop-down list.

When the Custom radio button is selected, you can enter your own dimensions personally.

Orientation
Choose between a portrait and landscape orientation for your document.
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Paper Colour

To change the paper colour, click on the box to the right and select a new colour.

The first time you open SymWriter, the default paper colour will be white.

When you change the paper colour, the background in SymWriter will change to reflect your new

settings.

As mentioned in Line Colour of Symbols (Page 40), you may want to change the paper colour to

give a good contrast with the symbol line colour. This is especially useful for enhancing the access

to readers with a visual difficulty.

Paper colour

Click to change paper colour [:I

.

O

Queue at the entrance when

hear the

Margins
Set the paper margins.

SymWriter 2 User Guide
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Speech

SymWriter comes with a speech function available on the toolbar and from the Speech menu. This
feature can be used to maximise your document in numerous ways. For example, with this feature
you could create a “talking book”. Due to the fact that the speech function will attempt to read any
sentence regardless of grammar or spelling, it can be useful for understanding the phonetics of
language and giving feedback on words as they are typed.

SymWriter comes with the male and female ScanSoft speech voices, Daniel and Serena.

Speech On Demand

There are two speaker icons on the toolbar that can function to provide speech feedback of the
written document.

— Click on the single speaker icon to listen to the selected sentence read aloud.
~ Click it again to hear the 'next' sentence.

@ To play the last sentence again, click the repeat speech icon.

These two options are also available from the Speech menu.

Auto Speech

With the speech function of SymWriter, you can listen to each letter, word and/ or sentence after it is
typed.

Use the Speech menu to choose the best settings for your

Windows Tools Help  jocyment.

|- Speak F6 & . .
|9 P : When an option has been selected, a border will appear around
%! Repeat Speech the corresponding icon. You can choose to have any

combination of the options activated at any time.

Speak after Letter !
Speak after Word Select Speak after Letter to hear each letter spoken after it is
L typed.

|| | Speak after Sentence

Select Speak after Word to hear each word spoken after it is
Speech On/Off » typed.

Speech Settings Select Speak after Sentence to hear each sentence spoken
after it is typed.
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Voice Selection

To choose a voice, select Speech Settings from the Speech menu. You will then be presented with
a new dialog that features a drop-down list of all the available voices. You can select any voice from
this list.

Speech | Windows Tools Help
«  Speak B E

Repeat Speech

3% Speak after Letter

Speech On/Off

Speech Settings

m Set voice speed X
.(c'i: SPEB k after Word Choose voice: [SnSoft Serena_Full_11kHz VJ
X% Speak after Sentence Wk spced
-

Slow

Save as Defaults] {Reshore to Defaults

Setting Voice Speed

To change the speed of the selected voice, select Speech Settings from the Speech menu and use
the slider in the Voice Speed section to change the speed.

To ensure that you have chosen the best settings, use the Test button after setting the slider.

Speech | Windows Tools Help

SymWriter 2 User Guide

7 Speak F6

Repeat Speech
2%  Speak after Letter ™ Set voice speed ol
.(c"‘: SPeak after Word Choose voice: lSnSoft Serena_Full_11kHz v ]
X Speak after Sentence Yokcs Speed

-
Speech On/Off » Slow Fast
Speech Settings Save as Defaults] {ReshorehoDefadis [ OK ] [ Cancel ]
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Spelling

Speel I SymWriter has a pictorial spellchecker. When a spelling error has
been made, SymWriter will offer suggestions from the dictionary
@ sleep including the associated symbol. This feature can assist with
symbol suggestions to help understand the meaning of words and
apee| help the correction process.
-_—
g Steel
La spell
Rspell
spiel
Learn This Word
More... .

Marking Errors

SymWriter comes with a spell checker. You can choose whether spelling errors will be marked
throughout your document or not.

To change the spell checker marking settings, select Settings... from the Tools menu and select
one of the radio buttons in the Spelling section.

Spelling
Check As You Type

@ Mark Spelling Errors
(") Do Not Mark Spelling Errors

Using the Simple Spell Checker

Speel I To see suggestions for a spelling error, click with the right
mouse button on the word. After a short pause you will see a list of
@ sleep suggested words illustrated by symbols where possible.
apee| If you do not want SymWriter to mark this word as a mistake,
= click Learn This Word.
g Steel
La spell
Rspell
spiel
Learn This Word
More... »
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Using the Full Spell Checker

Check Spelling

speel

LD sleep f
2 peel

%z steel

™ Res
s A

L3 spell

%@spell

word Yo Try

e

|

P

Try

-—
3 Ty the new word
" .

(ﬂ? Hear the sentence

»’) Back to original word
. .

=P o to next mistske
-

Learn ha new word {Close spaller

SymWriter 2 User Guide

| To activate the full spell checker, select Check Spelling... from

the Tools menu or click on the spelling icon if it is shown in the
toolbar set you are using.

The spell checker will search your document for any spelling errors.
When an error has been identified, a new panel will open on the
right side of the window. In the new panel, a list of suggested
corrections will appear. From this list, you can select a word to ‘try’.

To select a word to ‘try’, click on one of the suggested words. The
word will now appear in the space below Word To Try. To hear the
suggestion read aloud, click on the speaker icon next to box.

To see the suggested word inserted into your document, click Try
the new word. If the selection is not the one you want, click Back
to original word to put the original word back.

To hear the sentence containing the suggestion, click Hear the
sentence.

To review the next mistake, click Go to next mistake.

If you do not want SymWriter to mark your original word as a
mistake, click Learn the new word.

Once you have finished using the spell checker, click Close speller.

Page 79



Adding Extra Spelling Suggestions

It is possible for you to create your own suggestions for spelling errors. Some spelling errors could
be due to a phonetic approach at writing, for example “muvver” could be written instead of “mother”.

As the spell checker can only analyse letters, sometimes the suggested corrections will not be

accurate for the actual intended word.

muvver
7 mustve

s mustve
Malvern
miniver
makeover

Learn This Woed

More... »

To add suggestions for such spelling, select Edit Spelling Suggestions...

ooy

p
B Custom Spelling Suggestions
Add a New Entry Bxisting Entries
Misspeling, e.g. wheather » Error
Lt hert
Smm for this word, e.g. weather, ingeckshon
mother ingecshon
"’ Add ] kangero
movver

e

et

Possible Suggestions

hurt

injection -
injection

kangaroo

mother

naunhh

ok ][ comel ]

from the Tools menu.

Use the Add a New Entry section to add a new error, and subsequently enter any suggestions for

this word separated by a comma.

Click Add to add your new error and possible suggestions.

You can also update existing entries by selecting them from the Existing Entries section and

entering new suggestions. When you click on an existing entry, the Add button will be replaced by
an Update button. When you have finished adding suggestions, click Update.

Click Delete Entry to remove a selected/ highlighted entry.

When you are finished click OK.

SymWriter 2 User Guide
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Deleting Extra 'Correct' Words

A spelling mistake may be accidentally marked as correct and added to the SymWriter dictionary.
You can delete items from the list of additional words that have been added. From the Tools menu

select Edit dictionary...

2 kot your custom dictionary

committment
leamington

Find

Add & word

Delete selected words

| Delete

=

= ]

In the new dialog box you will find a list of entries that have been added to the SymWriter dictionary.

If there are lots of entries, you can use the Find box to search more easily.

When you have found an item that has been added in error, click on Delete to remove the entry.

When you have finished removing entries, click OK.

SymWriter 2 User Guide
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Show Parts of Speech
It is possible to mark verbs and nouns in your document as separate colours in order to distinguish
the parts of speech.

To configure these options, select “show parts of speech” from the Tools menu. You will be
presented with three separate choices:

Mouns
Yerbs

Configure...
To mark all nouns in your document, click Nouns.
To mark all verbs in your document, click Verbs.

When you have chosen to mark a part of speech, a black square will appear on the icon for the part
of speech.

To choose what colour the marked part of speech will be displayed as, click on Configure and
select a colour.

The default colour for nouns is blue and the default colour for verbs is red.

Ot = 3 Mw%

When go sightseeing, take camera and a guidebook.
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Wordlists

A Wordlist is a file that links words with graphics. If you type 'cat' in ‘symbol mode’ while using
SymWriter, the loaded Wordlist will automatically display the symbol associated with the word ‘cat’.
The symbols displayed when you type will vary according to the loaded Wordlist/s in SymWriter.

S
cat—>

You can choose to enable or disable different types of Wordlists in SymWriter depending on how
you want to use the program. You can also use SymWriter to create your own Wordlist.

Types of Wordlists

The Widgit Symbols

(Smart Symbolising) Wordlist is linked to the entire Widgit Symbol Database and is the only Wordlist
that can have the Smart Symbolising function active. With each software update, the Widgit
Database will also be updated - ensuring that you have the largest and most up-to-date vocabulary.

Note: You cannot edit the Widgit Symbol Database, but you can select your default symbol
choices (see Page 24).

User Wordlist

This Wordlist file is associated with your Windows Profile, therefore any changes that you make to
this Wordlist will only be accessible by you unless you share log-on details. There is only one user
wordlist per user.

NOTE: The user Wordlist is always active.

Topic Wordlists

These Wordlist files are generally reserved for short wordlists for small sets of topic-specific words.
These files are also easily shared amongst different users. When a document that is using a Topic
Wordlist is saved, the Wordlist and all of its entries will be integrated with the file. If you load this file
on another computer, the Wordlist, along with the document content will be accessible. Most
resource packs are likely to have a Topic Wordlist included, such as an ‘Ancient Egyptian History’
Wordlist for example.

Symbol Set Wordlists

This Wordlist file is the largest kind of Wordlist and is usually comprised of alternative symbol sets
that are often made by third-party companies like Makaton. This Wordlist is not easily shared like a
Topic Wordlist because it is not integrated with SymWriter documents although it is recognised by it.

When you first launch SymWriter, the default active Wordlist will be your User Wordlist in
conjunction with the Widgit Symbols Database (Smart Symbolising).
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Loading Wordlists

To manage the Wordlists currently active and available to SymWriter, you can use
the Symbols menu and select Symbols and Wordlists...

Using this dialog, you can configure how symbols will function according to your Wordlist
preferences.

Symbols Section

(@ =)
@Symbolsmd\'lordliﬁs
Symbols
o, A0, .= W
° ‘f Use Widgit Symbols = ioes Mt
\ B Yy

In the Symbols section, you can choose between Use Widgit Symbols,that will enable both Smart
Symbolising and access to the Widgit Symbol Database (as well as any enabled Topic Wordlists);
and Use Wordlists Only, that will only symbolise according to enabled Wordlists in the In-Use
Wordlists panel below. The latter could be useful when dealing with a specific topic that could be
complicated by the symbolisation offered by Use Widgit Symbols.

NOTE: You can select "Use Widgit Symbols" and not have any Wordlists enabled.

However, you cannot select "Use Wordlists Only" and return to your document if you have
not enabled any Wordlists.

Wordlist Section

| Topic Wiordists | _Symbol Set Wordists |
Avaiable Wordists Inwuse Wordists ‘1’
I newthree pigs = lec prepositions
I symbolworld wordlist J'
i Widgit Pictures
En&)leWot&sJ | Disable Wordlst l
|| More Options...
Save a5 Defaults "Lﬂtstore Defoults| 'L OK J | cancel |

The panel on the left will display all of the available Wordlists that have not been ‘enabled’ for your
current document. To enable a Wordlist, select that wordlist in the left hand panel and click
the Enable Wordlist button underneath.
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The panel on the right will display all of the ‘enabled’ Wordlists for your current document. The
Wordlist at the highest position will automatically be given symbol preference over the other
Wordlists. For example: if you had three Wordlists enabled which each had a different symbol for the
word ‘Cat’, the symbol from the topmost Wordlist of this panel would be the first choice in
SymWriter. You can use the Up and Down arrows to the right of this panel to change the order of
the Wordlists and the Disable Wordlist button to simultaneously disable and move the selected
Wordlist into the left panel.

When you have finished configuring your Wordlists you can click OK to return to your document and
commit your changes, or click Cancel to return to your document without saving any changes. You
can also save your changes to function as the default configuration by clicking Save as Defaults.
Click Restore Defaults to restore the original default settings.

Advice on Opening Multiple Wordlists
While you can choose Use Widgit Symbols and enable Topic Wordlists at the same time.

But if you choose Use Widgit Symbols and enable a Symbol Set Wordlist you will receive a
warning message.

You will be able to proceed but it is not recommended. Mixing diffierent symbol sets can confuse the
reader, as different sets visualise concepts differently. If you know the sets and their structure then it
is OK to mix sets, for example mixing an additional Photo Library with the Widgit Symbols. If you
don't, it is best to avoid mixing as they may represent concepts in disparate, different ways.

NOTE: Enabling the Widgit Symbols and a Symol Set Wordlists may also result in the
program running more slowly.

Restricted Symbols

Some symbols in the Widgit Database could be upsetting or not suitable for some users. Restricted
symbols are not displayed by default when you first launch SymWriter. To change access to
restricted symbols, you can use the Symbols menu and select Symbols and Wordlists...

Click the radio button next to More Options... to reveal the Show Restricted Symbols radio
button.

Click the Show Restricted Symbols radio button to view the categories of restricted symbols. Click
the radio button next to the category of restricted symbols that you want to be displayed to enable
the symbolisation of those terms.

¥ Maore Options...
Restricted Symbols
| Show restricted symbols
Categories
Drug and substance misuse
Human réproducton

|Save as Defauits| |Restore Defauits -

Cancel g

Click OK to return to your document and commit your changes, or click Cancel to return to your
document without saving any changes. You can also save your changes to function as the default
configuration by clicking Save as Defaults. Click Restore Defaults to restore the original default
settings.
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Changing Language

When you first launch SymWriter, the default language will be the one of the version that you own
(for example: if you own the US version of SymWriter, your default language selection will be
English US). You may have additional language packs available depending on the databases you
have installed. Changing the language will alter the symbolisation of words and sentences as
recognised by the symbol database. Other aspects that will change include: speech voice and the
spell checker.

Changing the language does not change the interface.

To change the language of SymWriter, select the Symbols menu and choose Language...

= Set the Current Language

Avalable Languages
English AU
IE_I English CA
English NZ
English UK

% English US

I Finnish

‘Save s Defauit| Restore Default o« || caxel

Click OK to return to your document and commit your changes, or click Cancel to return to your
document without saving any changes. You can also save your changes to function as the default
configuration by clicking Save as Defaults. Click Restore Defaults to restore the original default
settings.
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Saving Wordlist Changes

While you are writing a document, it is likely that you will use edit aspects of SymWriter such

as: Changing the Words for a Symbol (Page 25), Changing the Image for a Word (Page

26) and Changing the Colours in a Symbol (Page 27). Such changes will be saved to the current
document, however; you may also decide that you would like to save your changes to use on other
documents. You may also wish to simply remove wordlists entries from the document.

You can save and manage your Wordlist changes, and create new Wordlists by selecting
the Symbols menu and clicking Save Wordlist Changes...

" Save wordlist changes =)
Wordist Entries New Wordist name Wordists
feloc
James = - o thre
rabbit — . User Wordlist
squirred . .
Oeiete entry
» 2 -
Currently Seected Wordist
- A
Yy are some weedists grey?
Select Wordists
Fiter
Show: | All entries X
oK || conce

Wordlist Entries Panel

In the left hand panel titled Wordlist Entries, you will find the new symbols that have been created
during your session. What you can see in this panel is dependent on the Filter drop down box
underneath.

Filter

Show:

Entries in use

Entries notin use

When All entries has been selected, you will see all of the entries that you have made during your
session. When Entries in use has been selected, you will see all of the entries that you have made
during your session that are currently in your document. When Entries not in use has been selected,
you will see all of the entries that you have made during your session that are not currently in your
document.
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Wordlists panel

In the right hand panel titled Wordlists, you will see a list of all of your Topic Wordlists. The User
Wordlist will always be loaded. When a Wordlist is grey, it means that the Wordlist is not currently
loaded. You can load a Wordlist from this dialog by clicking the Select Wordlists button that will
take you to the Symbols and Wordlists... dialog.

Create New Wordlist

You can also create a new Wordlist using this dialog. To create a new Wordlist, type a name for the
new Wordlist into the space underneath New Wordlist Name and then click Make new
wordlist button.

New Wordlist name

James' Wordlist

( Make new wordlist

This new Wordlist will automatically be loaded, and added to the Wordlists panel.

Wordlists

James' Wordlist

IEC Preg

(;;‘1::_"1. oraw
User Wordlist
Widgit Pictures

Adding Wordlist Entries

You can add your Wordlist Entries to loaded Wordlists. To add a Wordlist Entry to a Wordlist, first
select the Wordlist in the Wordlists panel that you want to add to and make sure it is loaded. Then
select the Wordlist entry that you want to copy and click the Add button. If you want to add all of
your Wordlist entries, click the Add All button.

[ Delete entry ’
[ = Add |
[ = Add Al ]

Deleting Wordlist Entries
You can delete Wordlist Entries by selecting them in the Wordlist Entries panel and then
clicking Delete entry. If the entry you are trying to delete is in use, you will not be able to

delete it until it has been deleted from your document.

Click OK to commit your changes or click Cancel to return to your document without saving any
changes.
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Viewing Wordlists

To view your available Wordlists, you can select the Symbols menu and then Symbols and
Wordlists, where your Wordlists will be listed in the Wordlists panel.

If you want to view the contents of your Wordlists, you can use the Wordlist Manager. The Wordlist
Manager is an external application.

To open the Wordlist Manager go to the start menu, then choose:
“All programs > Widgit > Common > Wordlist Manager”

The Wordlist Manager is an ideal tool to help provide an overview of the extent of Widgit Symbols.
Without having to make any changes, you can look at every graphic and word in each Wordlist.

It provides a method for familiarising yourself with the way Widgit Symbols work, and may help you
to plan how you can alter, or create your own wordlists.

Editing Wordlists

You can use the Wordlist Manager to edit your Wordlists. The Wordlist Manager is an external
application.

To open the Wordlist Manager go to the start menu, then choose:
“All programs > Widgit > Common > Wordlist Manager”

There are several ways you may want to edit a Wordlist using the Wordlist Manager, for example:
updating the vocabulary by adding, editing and deleting words or updating the symbols by adding
custom graphics and qualifiers.
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SymWriter Environments

Environments in SymWriter make writing easier with the aid of Grids and Buttons. These can be
created with text only, text & symbol support or symbol only formats. This means that SymWriter can
support those who cannot write text but can write using symbols, and text writers with a limited
vocabulary.

One example of the benefits of using Environments is the feature’s ability to increase the
involvement and motivation of users by creating visual strategies, such as behaviour charts and
signage, or organisational tools, such as personal plans and shopping lists.

i - Wows Smetatin sne
W fie (G2 You fomen  Beaoh  Sgeech  fYedoes  Tooh My

GDBES DB cmcsonn “o MM B U 2z i s DO o ®Q
i BE SO ELEEIELE ¢4 = = wiii[#I[S=E

n

B _@ @;’m,
T@w is Monday [@] \
{lﬂ
Morning

E &4 (4 @

Register Assembly History Geoqrophyl
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Environments Glossary

A BT T T T P ET s b T .-~ -. Environments
1 0€ @ '+ &  The writing window for the Document, together with
e e i o o] Grids and other tools to assist writing is called the

Environment.

3 Document area
QO &)
lke

pars ed ched —< The document (or writing window) is the area of the
screen where you can type directly into, and which
can receive input from an active Grid(s).

Stages

A Stage is an area of the screen separate from the
document area that can hold Grids, Trays, Buttons
and Text Boxes.

o
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Cells

A Cell is a single entity within a Grid. A Cell usually
has a border and is used to contain text, symbols or

paper wood cloth | both.

Stacks

This is a set of Grids or Trays on top of one another but occupying the same
space on the Stage. For example, one Cell in a Grid may link to a new Grid in
the exact same location but with different Cells and options available.

If a Grid is part of a Stack, you will see the Stack icon in the bottom left Cell:
o &

You can view all Grids in a Stack using the Grid Viewer.

Actions

Actions are features within Cells or Buttons that have been configured to perform specific tasks
within a document. For example, you may want to create a delete button to perform the action of
deleting the previous word; or an action such as print linked to a new Grid etc.

| pr— |o— 7 R
P Edit Cell Actions
Avalable Actions Current Cel Actons:
-] !

Shortist | Recent | A1 - S m—
- I ‘ X Delete last woed [1’

>

Alignment X
Undo |4
Move the cursor
Text Selection 2.9
4 Delete
X backspace
X last woed
X Aslata

Description:

Deletes the word to the left of the text
Quredr.

"

P
o J
o J[ caxd ]
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Trays

A Tray is a free-form area where Graphics and Text Boxes may be positioned freely. Items on a
Tray can act like Cells, sending content to the document while containing actions. A Tray may also
have a graphic as a background.

1 Q

N
I LIKE

W

I DISUKE

3 &
N \é/

N .
1AM UNSURE ABOUT

=\
L.
\’

Buttons

A Button is similar to a single Cell that can be placed in a Tray or directly onto a Stage. It can also
contain actions.

0.0©®

Text Boxes

A Text Box is similar to a single Cell that can be placed in a Tray or directly onto a Stage. It can also
contain actions, and comes with the default assigned action ‘Send Cell Text'. It is similar to a Button.

Click on the button to start

Text-Mode

Text-Mode is used for writing into Grid Cells. You can choose this mode by clicking on
I the Text icon on the toolbar.

Object-Mode

Object-Mode is used for most other purposes, for example: resizing, linking, editing,
% appearance and moving items. You can choose this mode by clicking the Arrow icon on the
toolbar.
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Using an Environment

You can start using an existing Environment by selecting Use An
Environment from the SymWriter Launcher.

When you do this, you will be presented with the default folder for storing
Environments (C:\Users\Public\Documents\Widgit\SymWriter\Environments\).

O O O My Compuer + C * Users * Puble * Documents * Widgt * Symitirter * Esviromments *

Ny Compuer Templates

Alive or not

Blend Words sh-s!

Churchyard

E

E=~—v—7

_— Ilkq,'pl Sentences -
ﬁ Float and sank
I .i Halloween
Smcomt * Go

You can select a saved Environment to run from this folder in one of two ways: double clicking on
the Environment, or by selecting the Environment with one mouse click and then selecting Go.

T, || If you want to look at the most recently used Environments, you can select
Rl | [ Eree the Recent icon in the bottom left corner.
Float and sink.swe When you select an Environment with one mouse click from a folder or
Churchyard.swe from the Recent menu, you will see a preview of that Environment in the
The Date Todayswe  Panel on the right unless the Environment is from an older version of

Alive or not.swe Symwriter.

Halloween.swe

Opening Documents into

Environments O T A P T A e i N
When you have loaded an E g ' mgu ,3

Environment, you can open a .

document from the File menu or F :a". » N h\‘.;

toolbar and the document will be = ¥ W

loaded directly into the Environment. ~1?2% &

This can be useful if you have been e e e
using a complex Environment and
saved your document so you could "
continue at a later time. are celled priests.

Egyptian kings

are called pharaohs.
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Environments: SymWriter File Compatibility
While you are using SymWriter 2, you will be able to open Environments from previous versions of
SymWriter.

However, you will NOT be able to open Environments saved in SymWriter 2 using previous versions
of SymWriter.

If you try to open an Environment saved in SymWriter 2 using a previous version of SymWriter, you
will be presented with the following document:

HOowde EE SMB/US L MANEFI R *'F = 4

& @ [E 2

This ﬁle was created in Symlec 2

A o E

You need to update SymWriter to open it

Bl - &

The update is Free,

=[]

Visit:  downloads.widgitcom |

If you are using a previous version of SymWriter, you are entitled to a FREE update to SymWriter 2.
To obtain the update, follow the instructions and go to downloads.widgit.com.

Example Environments

SymWriter comes with a set of example Environments for you to use, and to give you ideas for new
Environments. These can also be edited in order to create new Environments.

NOTE: There are also templates for many of these Environments where you can add your
own content but all the formatting and links are ready-made.
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Saving and Printing your Work

When you are using an Environment, the same saving and printing options apply as when you are
writing a document. You will only be printing and saving the contents of the Document Area.

Saving
L'!J To save your work, simply select Save from the File menu, or click on the Save icon on the
—ul toolbar.

From here you can navigate to where you wish to save your document. The default path for
SymWriter documents are:
Win 7:

Shared Documents:
C:\Users\Public\Documents\Widgit\SymWriter

Personal Documents:
C:\Users\%username%\Documents\Widgit\SymWriter
- where %username% is a variable which the Windows will substitute.

WinXP:

Shared Documents:
C:\Documents and Settings\All Users\Documents\Widgit\SymWriter

Personal Documents:
C:\Documents and Settings\%username%\My Documents\Widgit\SymWriter
- where %username% is a variable which the Windows will substitute.

Once your document is saved, selecting save again will save over your file. If you wish to make a
separate copy of your document with a different name, select Save As.

NOTE: It is important to save your work on aregular basis.

SymWriter 2 User Guide Page 96



Printing
To print your document, go to the File menu and select Print... or select the print icon from

the toolbar.
When you choose to print, you will see the following dialog box:

= Print X
Genenal |
Select Printer
% Add Printer % CutePDF Writer
= Adobe POF & Fax

& Canon iR-ADV C5030/5035 UFR T on ryu_FS9 HP LaserJet 1100 (MS) or

‘ " ’

Satus Ready [ Prrttofie Prefeconces

Location Post Room
Comment Fing Pricter.
Page Range
O] N.ererdgoomvfl 52
& C
c —
[ em | cocs | I

From here you can choose which printer you want to use, how many copies you want to print and
you can adjust your printing preferences.

The options for setting printer preferences will be dependent on your type of printer.

If you have chosen to view your document as a continuous layout and want to see the page breaks,
select Page Break View from Page Layout in the View menu.
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Editing Environment During Use

You may be using an Environment to write a piece of work, when you realise that you need to make
a change. You can switch to the designer at any time whilst running an Environment to make any
changes.

There are two ways to edit an Environment you are using:
g Quick Edit - for making quick, non-permanent changes.

@ Full Edit — for making permanent changes.

Quick Edit

Quick Edit can be useful for making temporary changes. These could consist of adjustments such

as: modifying the vocabulary of an Environment to make it more accessible for a particular user,

adding content to make it more relevant or simply improvising a new feature (like a background
graphic for a Tray for example).

@ To use the Quick Edit function, press the button on
the toolbar, go to the Tools menu or press Ctrl+Q on

your keyboard. Quick Edit
When you have select Quick Edit, you will see the following
image in the bottom right corner: In Quick Edit mode, changes you make will
not be saved permanently into the

When you have finished making changes to the SCKAmenE. .

. To save your changes use the File menu.
Environment, press the green Play Button to return to
the document

NOTE: The changes you make in quick edit are temporary and will not be saved with the
Environment.

Full Edit

You should use Full Edit when you want to make permanent changes to an Environment, or save it
as a copy. Unlike in Quick Edit mode, after you have finished making changes you will be prompted
to save when you try to return to the document. This could potentially be distracting if you are
working with a student.

To enter Design-Mode for Full Edit access, select the Tools menu then Switch to
@ Designer and choose Confirm. You can also use the red Edit button, if it is available on the
current toolbar set.

When you have finished making your changes to the Environment, press the

@ green Play button to return to the document. You will be prompted to save your changes
when you do this. You can choose either Save, to overwrite the current Environment,

or Save As, to make a copy.

NOTE: You do not have to save the Environment to use it but it is recommended that you do.
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Side Panels

Side panels refer to the Symbol Chooser (Page 23) and the Graphics Browser (Page 33). These
panels are accessible by default when you are using Design Mode, as is the Grid Viewer.

Environments can be saved with either or both of the Side Panels visible or not. So when you run an
Environment the visibility of the side panels may change.

You can choose to show and hide the panels by using the appropriate options from the View menu.

Graphics Panel Symbols Panel Double panels
Symbols | Grachas | Symbos | Geaptwes Symbos and Graghas |
N s [ Smids |
, ’ ) Pk Symbos
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tad blackbed bloe

v "‘-.l" a{‘ Frd Symeal
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e § X |
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Speech

You can use the synthesised speech to read documents out, as you type or afterwards. The speech
function has additional application in Design-Mode mode due to the possibilities of using Cell
Actions.

For example, you could have an Environment featuring a Stage with a Grid, Button, Graphic or Text
Box that has been configured to provide audio feedback such as:

Cell text — Speaks the text visible in the selected Cell.
Pre-defined text — Speaks user-defined text.

Sentence — Speaks the text of the sentence containing the cursor (or immediately behind
the cursor if the current sentence is empty.

Paragraph — Speaks the text of the paragraph containing the cursor (or immediately behind
the cursor if the current paragraph is empty.

Repeat — Speaks the last spoken speech.

Play sound — Plays a specified sound file. The sound file must be a .wav or .mp3 compatible
format.

Of course, if you do not have any kind of equipment to hear audio, you may be unaware that
SymWriter is busy performing audio functions.

_ When SymWriter is playing audio, you will see the speaker icon in the bottom right corner
= of the screen.

The text that is being turned into audio will also be highlighted in green in order to indicate the
current active processes.

Il . e

R

G

Symwriter highligh‘ts as it speaks
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Switch Access

You can set up and use switch scanning in SymWriter. To use switch scanning you will need to
connect a compatible Switch to the computer, or you can use the keyboard or mouse. The USB
device, keyboard or mouse will generate a user-defined keystroke(s) when activated.

To turn Switch Access on, you can use the Switch button on the toolbar or press Ctrl+J on
o the keyboard

Alternatively, you can use the Tools menu to navigate to the Accessibility submenu and then
choose Switch Is On.

You can also configure how you would like your switch scanning to function with Switch Options: the
method of scanning, the amount of switches, customisable delay periods between switches, etc...

, To access the dialog for Switch Options, you can use the button on your toolbar if it is
57 available.

o

Alternatively, you can use the Tools menu to navigate to the Accessibility submenu and then
choose Switch Options...

More about Switch Access

Application is Busy Indicators

The actions associated with Printing and Speech, when activated, will cause SymWriter to change
the process priority, in which case SymWriter may seem to become unresponsive.
For example, if SymWriter is speaking, but you do not have sound turned on.

To ensure that you are aware of the current active processes, SymWriter will indicate that it is “busy’
with the relevant action icon in the bottom right corner of the document area.

s LS
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Making Environments

There any many different types of Environment you can make.

For example:

e An ‘Alive or Not’ activity featuring two lists of things that are either alive or not. Each correctly

selected Cell will insert the picture and word followed by a tab.

e A ‘Word Building’ activity, where words are built from two separate columns and correct
words are supported by symbols.

£
P4
@

In SymWriter you can:

e Create a new Environment

e Edit an existing Environment to update it, personalise it for a user or as a platform for
making a different kind of Environment with similar features

o Use a Template Environment that you can take in any direction you wish
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Creating a New Environment

To create Environments you need to start SymWriter using the Design An Environment button.

When you have clicked Design An Environment, the Environment Designer dialog box will appear.

2] Lay out a new environment (073m)

Choose the stage layout and panel preferences for the new
environment. You can change these settings later if you like.

Alternatively, you can load an existing environment or create one
from a template using the buttons below.

i, Load an environment |[ Recent Environments v

[ w Create from a template J

Lo ][ cance

From here you can choose the layout of your new Environment: how many Stages you want to be

active in your document and what side panels will be visible when the Environment is run in Run

mode.

SMWI,S#PM | | Stages | SidePanels |

Choose the side panels to
display when this
envirorment is used.

i

v

L
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Editing an Existing Environment

You can open a saved Environment, for the purpose of editing, from the launcher. Click Design An

Envir

onment.

Click Load An Environment to browse the saved Environments.
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You can also click on Recent Environments to select from the most recently used Environments.

Recent Environments ;v]

Halloween.swe

Egypt Sentences.swe
Churchyard.swe

Blend Words sh-sl.swe

Alive or not.swe

When you are in the designer, you can open an Environment with the Open Environment icon on

the toolbar. You can also do this with the File menu.

=
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Templates

SymWriter comes with a selection of Templates for creating Environments. These Templates are
usually partially complete with features such as stages and grids (sometimes with actions
configured) and empty Cells for you to put in your own vocabulary. Most templates also come with a
completed environment for you to look at and test.

Opening a Template

You can open a Template Environment from the launcher. Click Design An Environment.
When you have clicked Design An Environment, the Environment Designer dialog box will appear.

Select Create from a template to make a new Environment by selecting from a range of predefined
layouts.

wi Create from a template ]

The default file-path for saving and opening Environments also contains a folder called Templates.
This folder contains template Environments that feature aspects of typical Environments such as
Stages and Grids.

Saving from a Template

When you save the Environment it will go to the Save As dialog. This prevents you from overwriting
the template. If you wanted to, you would have to deliberately go back to the Templates folder to
save over the original.

You can also save your own files as templates into the templates folder. This is useful if you have
created some writing frameworks for other teachers to modify to meet individual needs.
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Saving Environments

When an Environment is saved in the designer, all of the Stages and their components are saved
along with the document.

% You can save the Environment with the Save Environment icon on the toolbar or click Save
Environment from the File menu.

NOTE: If you click the Save or Save As option from the File menu, this will save ONLY the
Document part of the Environment, not the actual Environment.

NOTE: If you have tested your Environment you may have some text and symbols in the
document. You will need to delete this before saving the Environment, unless you want it to
appear every time the Environment is opened in Run mode. See Testing your Environment on
Page 167.
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Stages

A Stage is an area of the screen separate from the document area that can hold Grids, Trays,
Buttons and Text Boxes.

Making a Stage from the Launcher

= B

- Lo ok 3 e ervironiment %l | When you select Design An Environment from the
launcher you will be presented with the Lay out a
Choase the stage layout and panel preferences foc the new new Environment dialog screen. To choose a

environment. You can change these settings later if you ke,

o0 Dl Stage for your document, click in the Stage that you

want to be available. When a Stage has been
selected, it will change colour to a darker shade of
blue.

When you click OK, you will see your document with
your selected Stage in Design Mode.

Alternatively, you can load an existing environment or create one
from a template using the buttons below.

i, Load an environment H RecentEnvironments v/

| i Create from a template |

To adjust the size of the Stage, you can drag the grey border
closest to the document area and adjust the size to your
preference.
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New Stages and Deleting Stages in the Designer

Stages can be added or removed at any time. You can add or remove Stages using the buttons on
the toolbar:

New Stage

Click on this icon to select the Add New Stage tool and then hover the cursor over one of
the four sides of the screen where you want to enter a Stage. You will see a new Stage
appear where it is possible to insert one, click the left mouse button to insert the Stage.

Delete Stage

Click on this icon to select the Delete Stage tool and then hover the cursor over the Stage
you want to delete. When the Stage you want to delete changes colour, click the left
mouse button to delete the Stage.

You can also choose both these options from the Environment menu.

Stage Appearance

Right click on the background of the Stage (outside the Grid) to get the context menu. Click on
Stage Properties...

The following dialog box that will open allows you to change the colour of a Stage, choose a colour
gradient and size.

fé B
2 Stage Properties X
Background
‘ Single Colour J Gradient
Colours Orientation
| i | O Vertical
—
) A Horizontal
Size
Stage size as a percent of height 36 % ~
(Save as Defauits| [Restore Defauits| [ ox ][ cawe ]

Colours and Gradient

Select the colour scheme you want for the background of your Grid. If you choose Gradient, you will
have the option of choosing two colours and the orientation.

Size

You can specify the stage size as a percentage of the total height. This is particularly useful if you
wish to make sets of environments that all match.
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Using Multiple Stages

You may want to use more than one Stage. Using multiple Stages can be beneficial in the way that
it can help separate out the information that can be sent to the document.

You could have a Grid functioning as a menu down the left Stage and a Stack of other Grids in a
Stage at the bottom, like in the example below. The Stage on the left contains a Grid featuring the
following Cells “The Beach”, “Nouns”, “Verbs”, “Adjectives” and “Pictures”; and the Stage at the
bottom contains a Grid hosting numerous Cells which constitute a word bank or picture bank
depending on which Cell is selected from the Stage on the left. Each different selection of one of the
menu Cells in the left Stage will access one of the Grids in the bottom Stack.

Ordering Stages

When you have multiple Stages you may want to change the order of the layers.

To change the order of the Stages, right click on the Stage that you want to change and select
either Bring This Stage Forward or Push This Stage Back.

Bring This Stage Forward
Push This Stage Back

Stage Properties...
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Grids

The Grid is one of the core components of an Environment. The Grid consists of an array of Cells
that will contain information and actions that you have determined.

An Environment can be used to plan such things as weekly activities using two Grids in an

Environment: one Grid on a Stage on the left of the Environment, and one Grid on a Stage at the
bottom of the Environment. The Grid on the left could contain days of the week to be sent to the

document and the Grid on the bottom could contain the activities, as well as action Cells to perform

other functions such as erase or enter a paragraph break.
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Making a Grid

To make a new Grid, select the New Grid icon from the toolbar, or choose Grids from
the Environment menu and select New Grid... When you have done this, the Create a
New Grid dialog box will appear:

= Create s New Grid
Layout | Appeacarce | Icentty PRy
Columns 2

Rows 2
Sae Cels for
9 Symbols and Text
Just Text

¥ Add 3 send action to each ¢l

‘Save 5 Defaudts) [Restore Defauits [ creste ][ coel

Columns
Use this spin box to set the number of columns in your Grid.

Rows
Use this spin box to set the number of rows in your Grid.

Size Cells for
Select whether you want symbols and text, or just text in the Cells. You can edit this later from Cell
to Cell.

Add a send action to each Cell

When this box is ticked, each Cell will send its content to your document when you are in “Play
mode”. Most Grids are used for sending content so you will usually want this feature ticked.
However, you may want to leave this un-ticked for Grids that will function as a menu. This feature
can be edited from Cell to Cell when the Grid has been inserted (see R1.12).

NOTE: If you have created Cells for Symbols and Text then the Send Cell Contents action will
be added
If you have created Cells for Just Text, then the Send Cell Text action will be added

Appearance Tab
Use this tab to change to an interface where you can modify the appearance of your Grid. More
about Grid Appearance on Page 113.

Identity Tab
Use this tab to assign a name and notes to your Grid. More about Grid Information on Page 143.

Create

When you click Create, a transparent preview of your Grid will be locked to the cursor. When you
hover the cursor over a Stage, a grey space will appear where it is possible for you to insert your
Grid. Click the mouse on a grey space to insert the Grid.

SymWriter 2 User Guide Page 111



Placing a Grid

When you have created a Grid, a preview Grid will be attached to the mouse cursor for you to place
on a Stage. As you move the cursor over a Stage, a grey space will appear where it is possible to
insert the Grid. To insert the Grid, click the left mouse button.

| |

It is possible to create a Stack by inserting a Grid on top of an existing Grid.

If you create a new Grid and move the cursor over an existing Grid, the existing Grid will turn grey
which indicates that the new Grid can be inserted here. Click the left mouse button to insert the
Grid and create a Stack.
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Grid Appearance

You can edit the appearance of your Grid to your own personal preference. This includes the option
to change the colour, sizes and shapes of parts of the Grid.

Make sure you are in Object-Mode and click the right mouse button. Now select Edit Grid
Appearance from the list of options. A new dialog box will appear:

fiam Edit grid properties
Appeaarce | Identity Preview
=
ainee) C—

&b

paper

==

s @
1 Q

Border Effects
Effect: Shod:m -
Effect Colour: I
Border vadth: 8

Line thidness: 4

Coener radius (%) 0

Internal sacgn: 6

L )

cloth

N

;\‘.‘w i
pYe N
','/-‘,.' "‘\T". ‘\\~

straw

Save a5 Defoutts| [Restore Defouits|

Background refers to the colour of the Cells.

Line refers to the colour of the border of the Cell.

Effect refers to the feature around the border of the Cell.
Effect Colour refers to the colour of the effect feature.
Border width refers to the width of the effect feature.

Line thickness refers to the size of the border of the Cell.

Corner radius refers to the curvature of the corner of the Cell.

Internal margin refers to the space inside a Cell that you can type into.

Linked Cells refers to the colour of Cells that have been linked.
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Colour

You can change the colour of the Background, Line, Effect Colour and Linked Cells in a Grid. To do
this, select the accompanying colour box to the right of whatever feature you want to edit.

Transparency

You can also choose to have the Background, Line and Linked Cells transparent. To do this, click on
the labelled button for whatever you want to change. When the button is selected, colour will be
enabled and when the button is deselected, the feature will be transparent.

Layout

The boxes next to Line thickness, Corner radius, Border width and Internal margin can be used to
set the values of the properties listed.

Any changes you make will be reflected in the preview panel on the right hand side of the dialog
box.

When you are content with your changes, click OK to apply them. If you want to set your changes as
the new default settings, click Save as Defaults and choose Restore Defaults if you want to revert to
the previous default settings.

You can also edit the appearance of individual Cells, or groups of Cells, by highlighting the Cell(s)
you want to change. Right click the highlighted Cell(s) and select Edit Grid Appearance from the list
of options.

Grid Information

You can edit the identity information for a Grid from the Identity tab, when creating a Grid, or editing
the Grid Appearance.

| Appearance | Identity | Preview
Name: Days Of The Week
Notes: 5 -

Toy =

Use this Grid to select the day of the week that you want to

plan. @

Mandzy

You can use this dialog box to name a Grid and enter notes. If you are using multiple Grids and/or
Trays, this can be a good way to help differentiate between them.

The name for a Grid or Tray will appear beneath the Grid or Tray in the Grid Viewer.
Any notes you have assigned to a Grid or Tray will appear when you hover the mouse over the Grid
or Tray in the Grid Viewer.
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Highlighting Cells

Cells can be highlighted in order to change the appearance of Cells or to apply actions that will
operate only on certain Cells. These adjustments could affect Cell colour, formatting and actions
etc...

To highlight Cells you need to be in Object-Mode.
Method 1: Select the Grid and then drag across a group of Cells.
Method 2: Select the Grid and then hold down Ctrl and click in each Cell you want to highlight.

If you change the appearance of selected Cells, then only those Cells will be previewed in the
appearance dialogue box. In this example, the background colour has been changed for the top row
of Cells.
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Moving and Resizing Grids

To resize and move a grid you have to select it in Object-Mode. You can do this by clicking on the
grid. When you have done this you will see a pink frame around the grid with blue drag points.

¢ To move the grid, drag the pink bars.
e To resize the grid, use the blue drag points.

If you want to move a Grid to another Stage, you can cut (Ctrl + X) and paste (Ctrl + V) it.
NOTE: if the Grid is in a Stack any changes you make will affect the whole Stack.

NOTE: you cannot drag a Grid off the Stage.

0 er . ) £ @

Moving and Resizing Multiple Grids on the same Stage

You can move and resize as many grids as you like simultaneously as long as they are all on the
same stage.

To do this, hold down the Ctrl key on your keyboard and click on each grid that you want to move
and/or resize.

When you have done this you will see a green frame around the grids with blue drag points.

e To move the grids, drag the green bars.
e To resize the grids, use the blue drag points.
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Resizing Individual Rows and Columns Grids

You can move the Cell boundaries to make an irregular Grid. To do this, position the mouse pointer
over the space between two Cells and the cursor will change to indicate that the Cell border can be
dragged.

Using the Grid Boundary for Resizing Columns and Rows

The Grid boundary can be utilised, not only for resizing and repositioning whole Grids, but also as a
means for resizing columns and rows.

To resize an individual column or row, select a Cell (in Object-Mode) belonging to the column or row
that you want to change.

e To resize this column, use the middle drag point on either the left or right bar of the Grid
boundary.

e To resize this row, use the middle drag point on either the top or bottom bar of the Grid
boundary.

You can also use the Grid boundary to resize multiple columns and rows.

To resize multiple columns or rows, select the Cells (in Object-Mode) belonging to the columns or
rows that you want to change. You can do this by holding down the Ctrl button on your keyboard
and then clicking inside the Cells. Then resizing the grid as described above.
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Merging Cells

Selected Cells can be merged. To do this, select the Cells that you want to merge in Object-Mode.

LLJ To merge the Cells, select the Merge icon from the toolbar, or select Merge Cells from
the Environment menu in the Grids subsection.

Alternatively, you can click the right mouse button, select Edit These Grid Cells... and
choose Merge Cells.
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Splitting Cells
You can split any Cell or multiple Cells, including those that have previously been merged. To split
Cells, select the Cell or Cells that you want to split in Object-Mode.

When you have selected the Cell or Cells that you want to split, either click on the Split Cell button
or choose Split Cells from the Environment menu in the Grids subsection.

] split Cell Horizontally
] split Cell vertically

Select the way you would like to split the selected Cell or Cells:

Split Cell Horizontally Split Cell Vertically

Split Cell Properties

When you split Cells that have various different formatting properties, the new Cells will
automatically adopt those properties relative to the Cell they originated from.

s i
& -8

I DISLIKE 1 DISLIKE
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Insert and Delete Rows and Columns

To insert or delete rows and columns, you need to be in Object-Mode.
There are a series of buttons on the toolbar for inserting and deleting rows and columns.

You can also find these options in Rows and Columns in the Grids subsection of
the Environments menu.

Use this button to insert a column to the left of the selected Cell.

ve

Use this button to insert a column to the right of the selected Cell.

Use this button to delete the column belonging to the selected Cell.
i

Use this button to insert a row above the selected Cell.

I

Use this button to insert a row below the selected Cell.

x
— Use this button to delete the row belonging to the selected Cell.

New Row and Column Formatting

~ When you insert new rows and columns from existing ones
that contain various different formatting properties, the new
rows and columns will automatically adopt those properties
relative to the row or column they originated from.
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Putting Content into Grids

Similarly to when you are using a document, or typing into the document area, you can write into the
Cells of Grids with just text, text and symbols, and you can also insert images.

The type of content that you put into Grids can create many different opportunities for using
Environments. For example, you could choose to enter symbolised text into a Grid, with one word in
each cell so that the Grid can be used as a word bank for writing with. Whole sentences or sentence
halves can be used to build up a story. Environments can be made in just text for more confident
readers to author documents.

text
symbols

Writing in Symbol or Text in Cells

When creating a Grid you will be able to choose whether the cells will be sized for ‘Symbols and
Text’ or ‘Just Text’. See more about making Grids on page 111. Your selection will determine
whether your typing into the Grid will be represented by symbol supported text or text only, and what
type of send action is added to the Cells.

Size Cells for

@ Symbols and Text
() JustText

When you have created and inserted a Grid into your Environment you can change the writing
mode. Press F10 to choose between writing with symbol support or text only, alternatively you can
use the Show Symbols button to choose between the two.

T| |

text %

symbols

NOTE: changing the writing mode after the Grid is created will NOT change the type of send
action in the Cell.

When writing into a Grid Cell you can edit the content in the same way that you would in a
document, for example: you could use the Symbol Chooser to select the most appropriate symbol,
replace a symbol with an image from the Graphics Browser or use F11 to change the text for a
symbol. More information about Writing in Symbols on Page 22.
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Adding Images to Cells

Grds | Symbots | Gooncs | Add a Graphic to a Cell

[ ¥ Show when this environment i run

—- . You can use the Graphics Browser in the right hand panel to navigate to a
;@- 4 graphic that you want to add to a Cell.

You can add individual Symbols and Graphics to Cells.

angelfish  ant " When you have found a Graphic that you want to use, select it by clicking
the left mouse button.
SR TV

antester badger

When you have selected a Graphic, a transparent replica of it will be
attached to the mouse cursor for you to place in the Cell. As you move the
B cursor over the Cell, a grey space will appear where it is possible to insert
W O

bat

the Graphic. To insert the Graphic, click the left mouse button.
bear

beetle

54

bilby bied

r

Add a Symbol to a Cell

To add a symbol to a Cell, first type the word for which you want to obtain the associated symbol
into the Find Symbol search bar in the Symbol Chooser and either press Enter on your keyboard
or click the Find Symbol button.

[ Find Symbol ] honey|

Select the symbol that you want to use from the Symbol Chooser. When you do this, a transparent
replica of it will be attached to the mouse cursor for you to place on the Cell. As you move the cursor
over the Cell, a grey space will appear where it is possible to insert the symbol. To insert the
symbol, click the left mouse button.

[ Grids | Symbols I Graphics |

[V] Show when this environment is run

@ Pick Up Symbols

S

You can also insert images from web pages or from locations on your computer copying and pasting
them.
More information about adding images from windows and browsers on Page 35.
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Cell Layout Defaults

Centre align paragraph settings is used by default and recommended for making the most of the
space in Cells.

Text and symbol size will automatically change for the best fit as you write into a Cell.

Similarly, as you enlarge a Cell in Object-Mode, the text and symbol size will change to suit the Cell
size. You can also use the Expand to fit button on the toolbar to ensure that Cell contents are the
best fit possible. More tips on making consistent sizes in cells on Page 128.

N2
W N

Sizing Content in Cells

Unlike in documents, or the document area of an Environment, you cannot use the respective drop-
down boxes for font and symbol size when you are modifying content in a Cell.

To change the size of Cell content, use the Increase Size and Decrease Text and Symbol buttons
on the toolbar:

1T 1T 1> (ow

To make the Symbol in a Cell as large as possible without affecting the text size, hold down
the shift key on your keyboard and click the Increase Symbol Size button.

To make the Text in a Cell as large as possible without affecting the symbol size, hold down
the shift key on your keyboard and click the Increase Text Size button.

Original Cell Symbol largest Text largest
e N—)
\- [—1
box b
box OX
> y y
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Tidy Cells

When you have created a Grid, it is likely that the text and symbol size will vary from Cell to Cell.

The Tidy Cells function allows you to have matching text and symbol sizes for as many Cells as you
like. Tidy Cells works by making all of the selected Cells the same as the Cell with the smallest
content. The Tidy Cells button can be found on the toolbar or you can choose Tidy Cells from

the Environment menu in the Grids subsection.

- ")

+
EEE 1o tidy all Cells within a Grid, select the Grid with the Cells that you want to tidy and click
the Tidy Cells button on the toolbar.

&

Cn Wednesday | goto

@A

O

the sports centre college

- ")

&
EEE 1o tidy specific Cells, switch to Object-Mode to highlight the Cells that you want to tidy and
click the Tidy Cells button on the toolbar.
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Expand to Fit

If you want the contents of a Cell to attain the best fit possible, click in that Cell and click the expand
to fit button on the toolbar. This can also apply to a group of highlighted Cells.

N2
W N

Seogull
Y
Jelfyflsh

NOTE: Using Expand To Fit will undo and size changes made, such as with Tidy Cells.

NOTE: If your Cell content doesn’t expand to fit the Cell, it may be that there are spaces
before or after your Cell content. If this is the case, you will need to delete the spaces created
in order to use the expand to fit tool.
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Using the Format Painter in the Designer

This section refers to the Format Painter function when designing an Environment in SymWriter. The
features of this tool remain the same as when it is being used in the document, however; due to the
possible presence of different writing areas in the designer (like Cells and buttons for example) there
are more ways to use it.

The Format Painter is a feature that can be used to copy text and symbol formatting properties, and
apply those exact properties to a selection made where possible. When you are designing an
Environment, this tool may be useful for quickly matching the formatting properties of specific Cells,
buttons or Text Boxes.

The Format Painter buttons can be found on the toolbar:
To copy formatting, click: £

To paste formatting, click: =

Animals ’@d

Lizar
Donkey Seagull
S A

Jellyfish

In this example, we want to change the formatting properties of each Cell so that they fall into three
distinct categories:

. green coloured font (for animals that live on land),
. purple coloured font (for animals that fly)
. and blue coloured font (for animals that live underwater).

The words ‘Sand Lizard’, ‘Little Egret’ and ‘Fish’ have already been completed, so these are the
Cells that can be used as specific starting points for using the Format Painter.

To begin format painting, you can select the ‘Sand Lizard’ Cell in Object-Mode, or click in or
highlight the word in Text-Mode and click the copy formatting button:

&
Liza}d f

To apply these copied formatting properties to the other relevant Cells, select the Cells by holding
down the ctrl button and clicking in each relevant Cell and then click the paste formatting button.
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Making Consistent Text and Symbol Sizes

When using the Expand to fit function across a range of Cells or entire Grid, you may find that the
end result is a Grid with inconsistently sized text and/or symbols. This can produce an
unintentionally messy effect.

Using the Tidy Cells function, you can ensure consistency across the Grid but you may also create
a disparity between the Cells with the amount of space available in each one.

It is possible to keep the text size the same while simultaneously making the symbol as large as
possible. To do this, select the text of one Cell, hold down the Shift button on your keyboard and
click the Increase Symbol Size button.

(Alternatively, you could decide to keep the symbol size the same while simultaneously making the
text as large as possible. To do this, you would select the text of one Cell, hold down
the Shift button on your keyboard and click the Increase Text Size button.)
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To apply the newly configured text and symbol size across the rest of the Grid, select the recently
modified Cell and copy the formatting with the copy format painter and then select the rest of the
Cells and use the paste format painter to paste the copied properties.

hippopotamus

NOTE: You can also use the format painter to copy this formatting across all Grids in your
Environment to ensure consistency.

Summary of the Steps
You could use the following steps to make an Environment featuring consistently formatted Grids:

Put in your content

Select the whole Grid and Tidy Cells

Select one Cell and Shift + increase symbol size

Pick up the formatting of that Cell with the Format Painter

Select the Cells/ Grids and paste formatting with the Format Painter

arwbdE
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Trays for Free-Form Layouts

In SymWriter it is not always necessary to use Grids. Grids can be quick and useful for arranging
Cells in a regular (or semi-regular) form. Sometimes it can be more user-friendly to have arranging
and size objects independently. In SymWriter a Tray is a holder for such a group of objects. A Tray
can also have a Graphic as a background.

On a Tray you can place:

Graphics
Buttons
Text and Symbol Boxes

like to take...

B e — . S—

Each of these objects has access to the Edit Cell actions dialog and so they can behave much the
same way as Cells in a Grid.

You can also link to a Tray in the same way as you can link to a Grid. Trays can be Stacked like
Grids. You can also use Trays and Grids in the same Stack.

The following toolbar can be used for shortcuts to functions relating to Trays:
i :j Use this button to make a new Tray.

T I Use this button to make a new Button.

1™ I Use this button to make a new Text Box.

~—" I Use this button to edit the appearance of whichever button or Text Box is selected.
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Making a Tray

£t

You will now be presented with the Create a New Tray dialog box.

You can make a new Tray by selecting the New Tray icon.

i Edit tray properties =)
| Appesrance :ld'enltyi ) lini
C )
L )|
[Shadow -
—
. =
1
Corner radius (%): 15
Save as Defauits| Restore Defauits| [ o ][ coance

From here you can edit the appearance of your Tray to your own personal preference. You can also
edit the information relating to your Tray, such as the name and notes using the Identity tab.

When you have created a Tray, a transparent replica will be attached to the mouse cursor for you to
place on a Stage. As you move the cursor over a Stage, a grey space will appear where it is
possible to insert the Tray. To insert the Tray, click the left mouse button.
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Tray Appearan ce
You can edit the appearance of your Tray to your own personal preference. This includes the option
to change the colour, sizes and shapes of parts of the Tray.

Make sure you are in Object-Mode and click the right mouse button. Now select Edit Tray
Appearance from the list of options (or the button on the toolbar).

A new dialog box will appear:

: Edit tray properties [rez]
Appesrsnce | Identity Preview
[ L D R E Eapas ale l : |
——
Border Effects
Effect Shadow v
Effect Colour: =]
Border vadth: 2 :
Line thidness: 1
Corner radus (%): 15
Save as Defaults| Restore Defauks ' OK 7-1 Cacel

Background refers to the main colour of the Tray.

Line refers to the colour of the border of the Tray.

Effect refers to the feature around the border of the Tray.
Effect Colour refers to the colour of the effect feature.

Border width refers to the width of the effect feature.

Line thickness refers to the size of the border of the Tray.
Corner radius refers to the curvature of the corner of the Tray.

Transparency

You can also choose to have the Background and Line transparent. To do this, click on the
labelled button for whatever you want to change. When the button is selected, colour will be enabled
and when the button is deselected, the feature will be transparent.

Layout

The boxes next to Border width, Line thickness and Corner radius can be used to set the values
of the properties listed.

Any changes you make will be reflected in the preview panel on the right hand side of the dialog
box.
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When you are content with your changes, click OK to apply them. If you want to set your changes as
the new default settings, click Save as Defaults and choose Restore Defaults if you want to revert
to the previous default settings.

Adding a Background Graphic

You can use a Graphic as the background for a Tray.

Use the Graphics Browser to find an image that you would like to use as a background for your
Tray. When you have found the Graphic, select it with the left mouse button and then click in the
Tray to drop it.

Make this Geaphic the Backgeound
Add a New God »
Add a New Teay »

Edt Actions for This Graghic...
Accessiilay »
X Delete This Geaphic

When the Graphic has been inserted into the Tray, click the right mouse button on the Graphic and
select Make this Graphic the Background.

Removing a Background Graphic

To a remove a background Graphic from a Tray, click the right mouse button on the Tray and
select Clear Background Image.

Edit Tray Appearance
Add a New Grid
Add a New Tray

Select All ltems in Stack

Clear Background Image
Accessibility

XK Delete this Tray
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Adding Graphics to Trays

To insert a Graphic into your Tray, select the Graphics Browser and choose a Graphic with
the left mouse button and insert it into the Tray by clicking again.

Or you can use the Symbol Chooser to search for and add a symbol to the Tray.

This Graphic can be just for decoration, or you can add actions to it to make it function like a Grid
Cell.

To add an action to the Graphic click the Action Icon in the top left of the image.

This will bring up the actions dialogue box.

— —,
£5H] edit Celf Actions m5cm
Avaiable Actions Current Cel Actions:
Shor tist ] Recent | Al ( o
- - § - Send a graphic | J
Print 5 @ Send pre-defined text ==
Saving And Loading & Send a retum ‘»i]
4 Send =
/‘ cell contents |XJ
[ cell text
& pre-defined text
cell graphic as a symbol E
@ return
4" tab
graphic
Speak And Sound
Sumbal Canteal 2 [ B\ copy at B Pas
(b
Descripbion:
Properties
Sends a return (a paragraph break) to the
document.
Text to send
Selacting "Only for non-blank paragraphs™ means ;
that the return wil not be sent to the document if The bucketis the sink
the cursor is aready on a blank paragraph,
: | Speak after sending
-
ok ][ coce |

The most common actions to use with Tray Graphics are:

. Send pre-defined text
. Cell Graphic as a symbol

You can also add any functionality actions to the item, such as ‘Send a return’, ‘speak’, etc
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Buttons

Buttons are similar to the individual Cells that compose a Grid. They can be assigned actions, linked
to Grids or Trays, used to contain a graphic or symbol supported text or text only.

A Button, unlike a Cell, can be placed in a Tray or directly onto a Stage.

When a Button has been dropped onto a Stage, it will behave the same way as when dropped onto
a Tray but it will remain permanently visible. This can be useful for making sure common actions
such as ‘Delete last word’ are always available.

Adding a Button

*\
’ To add a Button, you can select the New Button button from the toolbar.

When you click this button, you will be presented with the following dialog box.

| ) Creste s N Bumon ==
Appes ance
[Bsogrons | [}
[Laee | [ ——

Border £ffpcts
¥ect: None ®.
Effect Colour [——
Border weth s :
Une idess: s
Correr radhus (W) 00
ternal margen: 4

xee] CC—

Save a5 Defodts| Sestore Defauits [ ceswe || concel

Background refers to the main colour of the Button.

Line refers to the colour of the border of the Button.

Effect refers to the feature around the border of the Button.

Effect Colour refers to the colour of the effect feature.

Border width refers to the width of the effect feature.

Line thickness refers to the size of the border of the Button.

Corner radius refers to the curvature of the Button border.

Internal margin refers to the space inside the Button that you can type into.
Linked Cells refers to the colour of the button when it has been linked.

When you have created a Button, a transparent replica will be attached to the mouse cursor for you
to place on a Stage or Tray. As you move the cursor over a Stage or Tray, a grey space will appear
where it is possible to insert the Button. To insert the Button, click the left mouse button.
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Text Boxes

Text boxes are similar to the individual Cells that compose a Grid. They can be assigned actions,
linked to Grids or Trays, used to contain a graphic or symbol supported text or text only.

A Text Box, unlike a Cell, can be placed in a Tray or directly onto a Stage.

When a Text Box has been dropped onto a Stage, it will behave the same way as when dropped
onto a Tray but it will remain permanently visible. This can be useful for making sure common
actions such as ‘Delete last word’ are always available.

Text boxes are similar to Buttons, however; Text Boxes have very different default visual settings
that are more suited to text-based input.

Adding A Text Box

ITL
"1 To add a Text Box, you can select the New Text Box button from the toolbar.

When you click this button, you will be presented with the following dialog box.

21 Creste & New Teat 8o (5= |

Prevew

Appesrance

[Bacgrond |

Border wicth

Lne Badorwess:

Cormer radhus (%) 5

Interral marpn

[Lamed cets ] ———

Save a5 Defauts | Restore Defauins _ Creore | Cancel

Background refers to the main colour of the Text Box.

Line refers to the colour of the border of the Text Box.

Effect refers to the feature around the border of the Text Box.

Effect Colour refers to the colour of the effect Text Box.

Border width refers to the width of the effect feature.

Line thickness refers to the size of the border of the Text Box.

Corner radius refers to the curvature of the Text Box border.

Internal margin refers to the space inside the Text Box that you can type into.
Linked Cells refers to the colour of the Text Box when it has been linked.

When you have created a Text Box, a transparent replica will be attached to the mouse cursor for
you to place on a Stage or Tray. As you move the cursor over a Stage or Tray, a grey space will
appear where it is possible to insert the Text Box. To insert the Text Box, click the left mouse button.
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Linking Items on Trays and Stages

Buttons, Graphics and Text Boxes can all be put directly onto the Stage or on a Tray. As well as
being used to send information to the document, these items can also be linked to Grids or Trays.

Automatic Linking

When you have created an item, you can choose to add a new Tray or Grid to the Environment that
will automatically be linked to the item.

To do this, click the right mouse button on the item and select either Add a New Grid or Add a
New Tray and then choose Linked from This Cell.

(#| Edt Button Appearance...

Add & New Gnd >y Unlinked
Add a New Tray > Linked from This Cell
Edt Actions for This Button... Linked from This Cell with & Back Button

Clear This Button
Accessibility >

X Delete This Button

4

You can also choose Linked from This Cell with a Back Button that will automatically produce a
back button for the new Grid or Tray.

Manual Linking

Alternatively, you can select the Link Tool from the Grids tab and then
use the link icon to select the item that you want to link to a Grid or Tray.

B

Link Tool

You can also use the Link Anchor from within the item itself. ®

A
A green arrow will now emanate from the centre of the item and attach

itself to the mouse cursor.

Guide the arrow to the Grid or
Tray that you want to link the
item to in the Grid Viewer and
then click the left mouse
button to confirm the selection
and make the link.
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Linked Grids

As well as containing information that can be sent to the document, Grids can also function as a
means to access and navigate a large amount of vocabulary in the otherwise limited space provided

by Stages.

You could have a Grid acting as a menu down the left Stage and a Stack of other Grids in a Stage at
the bottom, like in the example below.

The Stage on the left contains a Grid featuring the following linked Cells “Animals at the Beach”,
“Nouns”, “Verbs” and “Adjectives”; and the Stage at the bottom contains a Grid hosting numerous
Cells which constitute different word banks (you could decide to add a picture bank too), the
contents of which being dependent on the selected Cell from the Stage on the left. Each one of the
menu Cells in the Stage on the left is linked to one of the Grids in the bottom Stack.

Anoals o e Besr

Verbs

Adjectives
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Automatic Linking

Automatically linked Grids, or auto-linked Grids are Grids that are automatically created and linked
from a Cell in a Grid. This can be useful if you want a Cell to function as a menu item and lead to
more options for a certain topic.

When you have created a Grid, you can choose to add a new Tray or Grid to the Environment that
can be linked from a Cell of your choice. The new Grid or Tray will be made in the same shape of
the original Grid and will become part of a Stack.

To add an auto-linked Grid, click the right mouse button on the Cell of the Grid that you want to link
from and select either Add a New Grid and then choose Linked from This Cell.

Edit Grid Appearance l
Add a New Grid » | Unlinked
Add a New Tray » | Linked from This Cell
& Select Al ems in Stack Linked from This Cell with a Back Button
Edit Actions for This Cell ...
Edit This Grid Cell »
Clear This Cell
: Accessibility »

' A Delete this Grid

Y

i = B
G6oto the Park

You can also choose the Linked from This Cell with a Back Button option that will automatically
produce a button that takes you to the previous Grid.

— Z @& & (R

Back 6o to a recordshop ‘ Goto a Cafe

& (@ k7 i

Goto a Clothes shop Meet friends
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Manual Linking

If you want to link from a Cell to a Grid or Tray on another Stage, you will have to make a link
manually using the Grid viewer.

To begin making the link, you can:
e use the Link Anchor from within the Cell. ®
or

e selectthe Link Tool from the Grids tab in the right hand panel and then use the link icon to
select the Cell that you want from.

G

Link Tool

When you have started a link, a green arrow will start from the centre of that Cell and attach itself to
the mouse cursor.

Guide this arrow to the Grid or Tray that you want to link the Cell to in the Grid Viewer and then
click the left mouse button to confirm the selection and make the link.

0O areent
] + |
o |
=L I e B 3
+
/': edl. 4
’/
& t
- - ?
i .
v
blue 1 ¢
N t
L
@
Urk ool
o Toobox

If there are several grid in the environment it may be useful to enable or disable scrolling in the Grid
Viewer, to give greater control over linking.
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Linked Cell Appearance

It is very easy to keep track of the linked Cells in your Environment if you wish to do so.

You can edit the appearance of your Grids to your own personal preference. Not only does this

include the option to change the colour of the Cells in the Grid but also the specific Cells that have

been linked.

To edit the appearance of Linked Cells, click the right mouse button on the Grid featuring the

Linked Cells and select Edit Grid Appearance from the list of options. A new dialog box will appear:

(& Edit grid properties =
Appesarce | Identity Preview
c——
e C———
Border Effects ////
Effec Shadon 1 Y/
Effect Colour: I
R : wood
Line thidness: 4
Coerer radus (%) 20
Internal ssargn: 3
=——
‘Save 25 Defonsts| [Restoce Defouts o J[ concs ]

Click on the box next to the Linked Cells button and choose from the range of colours.

[linkedcels ] |l ]

If you click the Linked Cells button itself, all Linked Cells in the selected Grid will become
transparent and you will not be able to choose a colour from the box next to the Linked Cells button.

Click the Linked Cells button again to turn colours for Linked Cells back on.

SymWriter 2 User Guide
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Changing the Order of Grids in a Stack

| Grds | symbols | Graptis |

9lsl2] ¢

SymWriter 2 User Guide

Using the Grid Viewer, you can change the order of the Grids in a
Stack.

In the Grid viewer, the outer border around a Grid (this border will be
the same colour as the Stage) will envelope the Grids and/or Trays
belonging to the same Stage.

The pale inner border around a Grid or Tray will envelope the Grids
and/or Trays that are in the same Stack.

When you are looking at a Stack in the Grids Viewer, you will have the
option of using the following buttons to change the order:

Use this button to move a Grid to the top of a Stack.

Use this button to move a Grid up one place in the Stack.

Use this button to move a Grid down once place in the Stack.

= = = =

Use this button to move a Grid to the bottom of a Stack.
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Grid Information

You can edit the identity information for a Grid using the notes button on the Grid viewer. =

Or you can click the right mouse button on a Grid or Tray in the Stage area and select Edit Grid
Appearance and then the ldentity tab.

These notes may be helpful to remind you of specific techniques when you re-visit the Environment,
or to give advice to colleagues who may edit a copy of this Environment later. If you have linked
Grids in your Environment for example, you may want to use the Notes field to detail which Grids
have been linked using Grid Names as references.

You can type the Grid Name in the Name field and you can make notes about your Grid in the Notes
field.

These notes will appear when you hold the mouse cursor over the relevant Grid in the Grid Viewer.

M Identity ’ Preview

[

Name: Days Of The Week

Notes:

Use this Grid to select the day of the week that you want to

@ .
plan.
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Home Grid

The Home Grid is the starting point for any Switch Scanning, and so it will have to be one of the
most immediately available Grid in a Document.

When you create a new Environment, the first grid that you insert will become the Home Grid by
default.

m The Home Grid is distinguishable due to the Home Icon in the bottom right Cell. This is also
evident in the Grid Viewer.

If you add another Grid to the Environment, you can change the Home Grid.

To change the Home Grid, click the right mouse button on the Grid that you want to make the
new Home Grid and select Set This Grid to Be “Home” from Accessibility.

Edit Grid Appearance -
Add 3 New Gnd » s
—_— Add a New Tray » ]
u Cp 't Al Bame i S )

LY ¢
Edit Actions for This Cell ...
Edit This Grid Cell »
- .. Clear This Cell
O

Accessibility » | [J Set This Grid to Be "Home"

XK Delete this Grid Edit Scan Behaviour...

65T Coneg Edit Auditory Scan...

The Home Grid has to be the first Grid to appear in its stack, so:

o If you set a Grid to be the Home Grid then it will automatically move to the top of the stack.
This is viewable in the Grid Viewer.

e Similarly, if a Grid in a Stack containing the Home Grid is moved to the top of the Stack in
the Grid Viewer, that Grid will become the new Home Grid.
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Setting Up Side Panels for the Environment

Side panels refer to the Symbol Chooser and the Graphics Browser. These panels are accessible by
default when you are using Design Mode, as is the Grid Viewer. You can choose to add and remove
them from the right hand panel by using the appropriate options from the View menu.

Showing panels when the environment is run
You can choose which side panels will be visible when the Environment is used in Run mode.

You can do this in two ways:
1. When you create the environment
You can choose, from the launcher option Design An Environment, which side panels will
be visible when the Environment is launched.

\ Stages ]—Ede Panels \

Choose the side panels to D D

display when this -

environment is used. Symbols Graphics
W] ¥]

2. After you have saved the environment

In Design-Mode by selecting the tab of either the Symbol Chooser or Graphics
Browser and then using the Show when this Environment is run radio button
underneath.

JE&;— Symbols —apl:\E\

’ [V] Show when this environment is run

You can also access these option from the Environment menu and Configure Side Pales
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Cell Actions

Cell Actions are commands that are associated with compatible items that feature in Environments
such as: Buttons, Cells, Graphics (that become Command Graphics when they are assigned
actions) and Text Boxes. You can have as many actions as you like assigned to any item.

When configured, these commands are capable of performing, with a single click, the majority of the
functionality that can be found through navigating the menus and toolbars of SymWriter. For
example, by clicking one Cell in a Grid, a sentence could be inserted into the document area, then
read aloud and finished by leaving the cursor on the next line.

Examples of Common Options:

e Send Cell Contents — Where the contents of the selected Cell are sent to the document.

e Link to Grid — Where the target Grid or Tray is made visible (in other words, is brought to
the front of a stack).

o New Paragraph —Where a “.”, “I” or “?” is sent to the document, then a new line before
capitalising the next letter.

e Print —Where the current document is printed using default settings.

Edit Grid Appearance
. Add a New Grid »
Testing Cells Add a New Tray »

. . [ €5 Select All ltems in Stack
When you are configuring actions for Cells, you can test how they - ;

will work when the Environment is launched. This can be useful ©  Test This Cell
for testing individual Cells without leaving the designer. To ‘test a

cell’, click the right mouse button on the cell that you want to test Fdyf axctions Foe T Eell

and select Test This Cell from the context menu. Edit This Grid Cell 4
Clear This Cell
Accessibility 4

| X Delete this Grid

Cell Action Indicators

There are small icons visible in a Cell that can indicate the status of and actions assigned to that
Cell.

[I#] The appearance of this icon depends on whether non-default actions have been applied to Cell.

If the icon is empty, that means there are no additional Cell actions applied to this item. If the icon
contains a dot, that means there are new Cell actions applied to this item. Click the action icon to
see all the actions linked to a Cell, and to add or delete actions.

@ This is the link anchor that becomes coloured when the Cell is linked to another Grid or Tray.

A This is the send icon that appears in a Cell when the Cell is configured to send Symbols and Text
to the writing document.

i This is the send icon that appears in a Cell when the Cell is configured to send Just Text to the
writing document.
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Cell Actions Menu

When you click the action icon in a Cell or click the right mouse button on a Cell and choose Edit
Actions for This Cell, you will be presented with the following dialog box:

[t Edit Cefi Actions
Avadable Actions Current Cel Actions:
Common Recent A
: /) Send cell contents t
Q] Link to gnd

QIO

/‘ Send cell contents ‘
Send 2 return
Send atab X
W Senda2graphic

New paragraph
.’5. Delete character left
X Delete last word
e Opeak sentence

Description:
Propertes

Sends the contents of the cel to the dotument,
@—-> ot e E C

Don't add extra spaces

In the left hand panel you will see the list of actions that you can add to the Cell

In the right hand panel you see the list of actions in the selected Cell

This panel will provide a description of the currently selected action

Properties shows you the editable properties of the selected Action

Click the Add button to assign the selected action to the Cell (you can also double click the
action to do this)

Copy All copies all of the Actions in the current Cell and Paste inserts the copied Actions
into the selected Cell/s

7. Delete an action from the Cell

8. Move the Actions up and down to change the order in which they are played.

SAE A

o

Actions List
In the left hand panel is a shortlist of actions that can be applied to the selected Cell.

The Common tab will be selected by default each time you open Edit Cell Actions. This shortlist
contains commonly used Cell actions.

The Recent tab contains the most recently used actions.
The All tab contains all possible actions.

When you want to apply an action to a Cell, select the action in the left hand panel and click
the Add button. This action will now appear in the right hand panel. Depending on the action
chosen, you may be able to adjust the properties using the radio buttons in the Properties section.
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Copying Actions to Other Cells

7V Sand el contents [ i ] You can copy Actions from any Cell or Stage item.
o T This is particularly useful when you have many Cells
;; Sp S in an Environment that you wish to function in the

€nd a return

same way.

(X]

To copy Cell actions, go to the Actions menu from
that Cell, and click the Copy All button under

the Current Cell Actions panel. This copy action will
remain on the clipboard until it is replaced, so you can
open another Edit Cell Actions dialog and use

the Paste button to insert the copied actions.

(B o] [ |

NOTE: If you are copying actions to a Cell that already contains actions, you will be
prompted with a warning stating that you are about to replace all current Cell actions.

Changing Actions on Multiple Cells

To change actions on multiple Cells, simply highlight the Cells that you want to edit in Object-
Mode and then select Edit Actions for These Cells... You will now be presented with the same
Edit Cell Actions dialog box.

0 @/

-~ ~

Edit Grid Appearance

Add a New Gnd »

Add a New Tray »

Select All Rerns in Stack

Edit Actions for These Cells ...

Edit These Grid Cells »

+ Clear These Cells
Accessibility »
XK Delete this Grid

~

mouse
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Ordering Actions

When you have applied all of the Cell actions that you want, you can change the order of the actions
by highlighting individual actions with the left mouse button and then using the arrow buttons next

to the right hand panel.

/' Send cell contents [I]
b Speak sentence
'.-g’; Send a return

]

B Copyal | [ Iy Pase |

The order of the actions is very important: each action will be applied in the order in which it
is listed.

For example, if you wanted to ‘send Cell contents’ and then ‘start a new line’, you would make Send
Cell contents the top of the list of Cell actions and Send a return second. If you had these actions
the other way around, the Cell contents would always be entered on the next line.

Current Cell Actions:

;‘ Send cell content s R
, - 3 + R
% Send a return S s LS

Current Cell Actions:

A s & “ @ !
& Send a return Aot S (X
s 8 o R « M

/-' Send cell content- e Lo S

Note that the Return is sent BEFORE the contents.
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Action Properties

The All actions list is divided into categories. To view each category, click the arrow next to the
relevant category.

Available Actions

| Common I Recent | Al ]

> Alignment
> Move the cursor ‘
4 Text Selection |=
to the beginning of the line "
to the end of the line
select character left
select character right
select up
select down
select previous word
select next word
select to paragraph beginning x

Some actions are complete in themselves, like Delete last word for example, whilst others require
the input of additional information.

Type 1. Actions that have optional properties

The Send Cell contents action, for example, can have extra information assigned using the
properties section. None of these additional actions are selected by default.

Properties

["] speak after sending
[7] Don't add extra spaces

Another example is the Send a graphic action, where there is always a selection made by default.

Properties

Alignment

@ Left () Centre () Right

SymWriter 2 User Guide Page 150



Type 2. Actions that MUST have properties set

2(a) Actions that need text:

For all ‘Type 2’ actions, the action, when added to Current Cell Actions, will appear highlighted in a
red colour to indicate that it requires additional information. If you try to return to the document by
clicking OK without entering any additional information, you will be prompted by a dialog box to enter
the missing information.

:f’fs? Send pre-defined text

In this example, the action Send pre-defined text from the Send category has been added
to Current Cell Actions. In this scenario, you would need to supply the text to send.

Properties

Text to send

(| speak after sending

2(b) Actions that need colour:

One example of this action is change text colour from the Text Formatting category. Here you
need to supply the colour.

Properties

%--------
ECO NN
] NN EE

1] [ T
(] ] [ [ [0 O [

[ More Colours...

Colour

]
]
]
=0
[

2(c) Actions that need a size:

Examples of such actions are Set font size from the Text Formatting category, Set symbol
size from the Symbol Sizing category and Set graphic size from the Paragraph
Graphics category.

Properties

Font size

4>

0

2(d) Actions that need a file-path or URL of web page:

One such example of this is the Load document action from the Saving and Loading category,
or Link to Grid from the Link category.

Properties

File name
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2(e) Actions that need a Link

The Link to grid action requires you to supply the name of the Grid that you want to link the
selected Cell to. You can do this by using the drop-down box.

NOTE: To use this action you need to have named your Grids.

Properties

Target grid or frame

actions
animals objects
describing
more words
places

Using the Link to an Environment action, you can configure a Cell to open any existing
Environment that you have access to on your computer. To select a target Environment you can use
the folder icon to navigate to your desired Environment. If you want to transfer your document to the
new Environment, click the Transfer Document check-box, otherwise the new Environment will

load with a blank document area.

NOTE: If you do not want to transfer your document, you may want to add a Save option to your
Environment. This Save action could be in the same Cell, as long as the Save action is ordered
above the Link action, or a new Cell or Button. Ideally, this option should be visible before the option
that takes you to a hew Environment. This will enable the user to Save their work before it is

removed for the new Environment.

Properties

Target Environment

=

("] Transfer Document

2(f) Actions that need Clipboard Content

To configure a Cell with the action Send
Symbolised Content, you will need to enter
some symbol content into the main document
and then copy it to the clipboard (you can do
this by highlighting the text, clicking the right
mouse button and selecting copy or pressing
Ctrl+C on your keyboard).

This copied text will be the symbolised content
that is sent to the document, so whatever
symbol choices you make will be reflected
each time you use the Cell.

When you have copied the text you want to
use for Send Symbolised Content, select
the Edit button from the Properties section
and then click Paste from Clipboard.

SymWriter 2 User Guide

™" Edit Document Content @
To edit this property, select some text in the main document
and copy it to the dlipboard. {Paste from Ckpboardl
Add the content to the action using the "Paste” button. o
= %
& 6 =} e=o
Anbis wosthe god of the dead He led the dead through
¥
darkness.
;rCopy to Clipboard i ‘ Close i
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List of All Actions

Alignment
Action Name
Align paragraph
Align image

Move the Cursor

Action Name

Move cursor left

Move cursor right

Move cursor up

Move cursor down

Move cursor aword left
Move cursor a word right

Move cursor a paragraph up

Move cursor a paragraph down

To start of line
To end of line

Beginning of document

End of document

Text Selection

Action Name

Select to the beginning of the
line

Select to the end of the line
Select a character left

Select a character right
Select up

Select down

Select previous word

Select next word

Select to paragraph beginning

Select to paragraph end

Select to the beginning of the
document

Select to the end of the
document

Select all

SymWriter 2 User Guide

Action Description
Aligns paragraph left, right or centre
Aligns image left, right or centre.

Properties

Action Description
Moves cursor left in a document.

Properties

Moves cursor right in a document.

Moves cursor up in a document.

Moves cursor down in a document.
Moves cursor a word left in a document.
Moves cursor a word right in a document.

Moves cursor a paragraph up in a
document.

Moves cursor a paragraph down in a
document

Moves cursor to the start of line.
Moves cursor to the end of line.

Moves cursor to the beginning of
document.

Moves cursor to the ending of document.

Action Description Properties

Selects to the start of line.

Selects to the end of line.

Selects a character left in a document.
Selects a character right in a document.
Selects upwards in a document.
Selects downwards in a document.

Selects the previous word in a
document.

Selects the next word in a document.

Selects from the cursor position or
current selection to the beginning of the
paragraph.

Selects from the cursor position or
current selection to the end of the
paragraph.

Selects to the beginning of the
document.

Selects to the ending of the document.

Select all of the text of the current
document.

Page

REQUIRED: Left, Centre, Right
REQUIRED: Left, Centre, Right
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Remove text selection
Select word

Select paragraph

Delete

Action Name

Delete left

Last word

Delete right

Link

Action Name

Link to Grid

To previous Grid

To an Environment

Open
Action Name

Web page

Program

Page Navigation

Action Name
Move to next page

Move to previous page

Move to start page
Move to last page

SymWriter 2 User Guide

Removes the text selection in the current

document.
Selects the current word at the cursor.

Selects the whole of the paragraph at
the cursor position.

Action Description

Deletes a character to the left of the text
cursor, or deletes any selected text. This

is the equivalent of the Backspace key on

the keyboard.

Deletes the word to the left of the text
cursor.

Deletes a character to the right of the text

cursor, or deletes any selected text. This
is the equivalent of the Delete key on the
keyboard.

Action Description

Makes the target Grid or Tray visible (i.e.
brings it to the front).

The target Grid or Tray can be in the
same Stack, or a different Stack to the
linked Cell.

NOTE: to use this action you need to
name your grids

Returns to the previous Grid.

Closes the current environment and
opens a new one, optionally transferring
document content to the new
environment.

Action Description

Launches the specified web page in the
defaults web browser.

Launches a specified program (e.g. an
executable).

Action Description
Moves to the next page in a document.

Moves to the previous page in a
document.

Moves to the starting page of a document.

Moves to the last page of a document.

Properties

Properties

REQUIRED: Target grid or frame.

REQUIRED: Target Environment.

Properties

REQUIRED: URL of web page

REQUIRED: Program file name

Properties

Page
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Parts of Speech

Action Name Action Description Properties
Unmark the paragraph Unmarks the paragraph colour to black.

Mark the noun Marks the nouns of a paragraph in colour.

Mark the verb Marks the verbs of a paragraph in colour.

Print

Action Name Action Description Properties

Prints the current document using the

Current document default printer settings.

Saving and Loading

Action Name Action Description Properties

Saves the current document. The filename

Save document as is determined by the student in user mode.

Saves the current document under the
specified filename. The filename is

Save document determined by teacher in Design Mode. REQUIRED: File name
Saving multiple times will cause files to be
overwritten.

Loads the document specified by the

Load document REQUIRED: File name

filename.
Load Environment L_oads the Environment specified by the REQUIRED: File name
filename.
Send
Action Name Action Description Properties
OPTIONAL: Speak after
Sends the contents of the Cell to the sending
Send Cell contents document. OPTIONAL: Don’t add extra
spaces

Sends the text in the Cell to the OPTIONAL: Speak after sending

Send Cell text document, as if the user had typed it. SpZ(EIeOSNAL: Don't add extra

REQUIRED: Text to send

Send pre-defined text Sends user defined text to the document. OPTIONAL: Speak after sending

Sends user defined content to the
document, keeping symbol choices.

Sends user defined text to the document,
Send Cell graphic as a symbol with the graphic in the Cell as the symbol
for the text.

Send symbolised content REQUIRED: Document Content

REQUIRED: Graphic in the Cell
REQUIRED: Text to send

Sends a return (a paragraph break) to the
document. Selecting ‘Only for non-blank

Send areturn paragraphs’ means that the return will not OPTIONAL: Only for non-blank

be sent to the document if the cursor is paragraphs
already on a blank paragraph.
Send atab Sends a tab space to the document. OPTIONAL: Speak after sending

Sends the graphic in the current Cell to
Send a graphic the document. This action is only valid if
there is a graphic in the Cell.

REQUIRED: Left, Centre, Right
REQUIRED: Graphic in the Cell
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Speech and Sound

Action Name Action Description Properties
Speak Cell text 22ﬁaks the text visible in the selected
Speak pre-defined text Speaks user defined text. REQUIRED: Text to say
Speaks the text of the sentence
containing the cursor (or immediately OPTIONAL: don’t move to a new
Speak sentence X ) .
behind the cursor if the current sentence page after speaking
is empty).

Speaks the text of the paragraph
containing the cursor (or immediately
behind the cursor if the current paragraph
is empty).

Speaks the last spoken speech (i.e.
repeats last speech).

Plays a specified sound file. The sound
Play sound file must be a .wav or . mp3 compatible REQUIRED: Sound file
format.

Speak paragraph

Speak repeat

Symbol Control

Action Name Action Description Properties
Changes the symbol to alternative
Change symbol symbols within a set of symbols. This is

the F9 key on keyboard.

Turns off or on symbols on the document.
In other words, alternates between text or
symbol mode. This is the F10 key on the
keyboard.

Changes the text of a symbol (or symbols)
to custom text. The picword will show the
same symbol and the custom text. This is
the same as the F11 key on the keyboard.

Turn off/on symbols

Retext a symbol REQUIRED: New symbol text

Symbol Sizing

Action Name Action Description Properties

Increases the size of the symbol and text
of a paragraph.

Decreases the size of the symbol and text
of a paragraph.

Increase symbol size Increases the size of the symbol.
Decrease symbol size Decreases the size of the symbol.

Increase symbol & text size

Decrease symbol & text size

Sets the symbol size to a pre-determined

Set symbol size REQUIRED: Symbol Size

size.

Paragraph Graphics

Action Name Action Description Properties

Increase graphic size Increases the size of floating graphics.

Decrease graphic size Decreases the size of floating graphics.
Sets the floating graphic size of the

Set graphic size current document to a pre-determined REQUIRED: Graphic Height
size.
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Text Formatting
Action Name

Bold the text

Italicise the text

Underline the text

Change the text colour

Change the font

Font normal

Indent paragraph

Un-indent paragraph

Bullet paragraph
Un-bullet paragraph
Set font size
Toggle caps lock
Increase text size
Decrease text size

Increase symbol & text size

Decrease symbol & text size

Sentences and
Punctuation

Action Name

New sentence
New paragraph
Capitalise next letter

Undo

Action Name
Redo
Undo

SymWriter 2 User Guide

Action Description

Sets bold at the current cursor position,
and sets bold on any selected text.

Properties

Sets italic at the current cursor position,
and sets italic on any selected text.

Sets underline at the current cursor
position, and sets underline on any
selected text.

Changes colour at the current cursor
position, and changes colour on any
selected text.

REQUIRED: Colour

Changes the text fontname at the current
cursor position, and changes text
fontname on any selected text.

Removes text formatting, bold, italic,
underline at the current cursor position
and any selected text.

Indents the paragraph by one tab stop to
the right.

Un-indents the paragraph by one tab stop
to the left.

Adds bullet points to the paragraph.
Removes bullet points from the paragraph.
Set the font size to a pre-determined size.
Toggles the caps lock.

Increases the selected text size.

REQUIRED: Font

REQUIRED: Font Size

Decreases the selected text size.

Increases the size of the symbol and text
of a paragraph.

Decreases the size of the symbol and text
of a paragraph

Action Description Properties
Sends a “.”, “I” or “?” to the current text and REQUIRED: Sentence
capitalises the next letter. terminator “.”, “I” or “?”

“n @

Sends a “.”, “I” or “?”and then a new line to

the current text and REQUIRED: Sentence

H “n “'!! “f)!!
finally capitalises the next letter. terminator °.%, 1" or
Makes the next letter written a capital letter.

Action Description Properties

Redo a change.
Undo a change.
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Switch Access

In SymWriter, Switch Access only works when running an Environment.

You can set up and use switch scanning in SymWriter. To use switch scanning you will need to
connect a compatible Switch interface to the computer, or you can use the keyboard or mouse
alternatives. The USB device, keyboard or mouse will generate a user-defined keystroke(s) when
activated.

These keystrokes are also useful for teachers to test activities for their switch accessibility without
the need for switches to be connected. You will need to make sure that the keys that you define for
switch scanning are not keys that you will want to use for purposes other than switch scanning.

Turning Switch Access On

To turn Switch Access on, you can use the Switch button on the toolbar or press Ctrl+J on
S the keyboard.

Alternatively, you can use the Tools menu to navigate to the Accessibility submenu and then
choose Switch Is On.

Switch Options

To access the dialog for Switch Options, you can use the button on your toolbar if it is
5Y available.

e

Alternatively, you can use the Tools menu to navigate to the Accessibility submenu and then
choose Switch Options... The default tab that will open is the Mode tab.

Scan Mode
2ol Scan Mode refers to the way that Cells and items in Trays are
@ Horizontal scan navigated.
Vertical scan
Column/Row scan There are various different modes of scanning available:

") Row/Column scan

Directional scan

Horizontal Scan (The default Scan Mode)
When this is selected, the scan indicator will move horizontally from left to right. When the indicator
reaches the last Cell in a row, the indicator will continue to scan the next row in the same way.

Vertical Scan

When this is selected, the scan indicator will move vertically from top to bottom. When the indicator
reaches the last Cell in the column, the indicator will continue to scan the next column in the same
way.
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Column/ Row Scan

When this is selected, the scan indicator will highlight a whole column and will move to the next
column with a single “beep” from left to right. When a selection is made, the scan indicator will move
down the individual Cells in the column. When the indicator reaches the bottom Cell, the indicator
will disappear and a double “beep” will be sounded. A selection made at this time will allow you to
continue scanning the whole columns and if you choose to continue scanning you will begin at the
top of the same column.

Row/ Column Scan

When this is selected, the scan indicator will highlight a whole row and will move to the next whole
row with a single “beep” from top to bottom. When a selection is made, the scan indicator will move
along the individual Cells in the row. When the indicator reaches the last Cell in the row, the
indicator will disappear and a double “beep” will be sounded. A selection made at this time will allow
you to continue scanning the whole rows and if you choose to continue scanning you will being at
the first Cell in the same row.

NOTE: When a selection has been made in either Column/ Row Scan or Row/ Column Scan
mode, the default configuration will return the scan indicator to the starting point of the
current grid with the exception of when you select a linked grid (in which case the scan
indicator will go to the starting point of the linked grid).

This default configuration can be changed using Edit Scan Behaviour function in Design-Mode.

Directional Scan

When this is selected, you will be able to control the scan indicator by choosing keys that you would
like to navigate with. You can configure this mode using the Current Mapped Keyboard Keys For
Use In Directional Scanning section of Switch Options that will now be accessible.

Mapped Keyboard Keys For

This section allows you to set your own keys for directional
scanning. The default settings “Up”, “Right”, “Down” and “Left” refer
to the directional keys on the keyboard. To change the mapped

® keys, select the button you want to change and press a new key to

replace it.

Current mapped keyboard keys for use in drectional scanning

i

NOTE: When a selection has been made in any mode apart from either Column/ Row Scan or
Row/ Column Scan mode, the default configuration will not move the scan indicator at all
unless alinked grid has been selected (in which case the scan indicator will go to the
starting point of the linked grid).

This default configuration can be changed using Edit Scan Behaviour function in Design-Mode.

NOTE: All Scan Modes apply to regular Grids. It is also possible to scan items in Trays but
you will be required to set the scan order manually.
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Edit Scan Behaviour

[ ; Options

Configures how a cell behaves after a
select action in switch scanning

On Selection Action
Move to next cell

9 Stay on this cell
Move to end cell

Move to start cell

Apply to all cells on the grid

[ o ][ conce ]

=

SymWriter 2 User Guide

You can configure how Cells will behave after they have been
selected in switch scanning. Through being able to customise the
scan behaviour of Cells, you can choose the most convenient way
switch scanning will work for users.

To edit the scan behaviour of Cells, first make sure you are

in Object-Mode and highlight the Cell (or group of Cells) that you
want to edit. Now click the right mouse button and select Edit Scan
Behaviour...

The following dialog will appear:

The settings that you choose here will apply to the highlighted Cell,
highlighted Cells or to all the Cells on the Grid if you click the Apply
to all cells on the grid checkbox.
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Auditory Scan

When Auditory Scan has been enabled, the text visible in each scanned item will be spoken.

The Auditory Scan function can be enabled or disabled using the appropriate checkbox in
the Mode Tab in Switch Options.

Auditory Scan

[¥| Enable

There may be occasions when you want to use the auditory scan function for items where there is
no text visible, or when you’d rather have a sound file activated or pre-defined text spoken instead of
the visible text.

To configure specialised auditory scan settings, make sure you are in Design-Mode and

have Object-Mode selected. Click the right mouse button on the Cell or item on a Tray that you
want to edit and choose Edit Auditory Scan... from the Accessibility submenu. You will then be
presented with the following dialog box:

P =

lass Auditory Scan Options
Configures the auditory scan for the selected cell
Audio From
@ Cell text Custom text Sound fie
Text Speech
Sound filename

o« [ conel ]

Cell text is the default setting. When this radio button is selected, the text contained in an item on a
Stage or Tray will be spoken when highlighted by the scan indicator.

Custom text allows you to create your own text that will be spoken when the item on a Stage or
Tray is highlighted by the scan indicator. Use the box next to Text Speech to type your text.

Sound file allows you to choose a compatible audio file that will be sounded when the hosting item
on a Stage or Tray is highlighted by the scan indicator.

When you are running an Environment, you can activate the configured auditory scan options by
using a mouse button. You can choose the mouse button in the Switch Options in the Use Mouse
As Switch section with the drop down box next to Go to Cell/ Auditory scan.

Goto cell / Auditory scan: |Right Button ¥
Right Button
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Moving Between Unlinked Grids

Use Mouse As Switch

[¥] Use mouse buttons as switches
("] Swap mouse buttons
Mapped Mouse Buttons For

Scan: Right Button
Goto cell / Auditory scan: Middle Button
Select: Left Button

Goto cell / Auditory scan: |Middle Buttor ~

While switch scanning, the conventional way of moving between Grids is achieved through
navigating the scan indicator to a linked Cell and then selecting it. Switch scanning will then
commence from the starting point of the linked Grid.

If you are using an Environment with multiple Grids that are unlinked, you can still access them
through switch scanning; but you will have to use the mouse.

You can find out what mouse button will enable you to access another Grid by accessing
the Tools menu, then Accessibility and then choosing Switch Options...

In the Use Mouse As Switch section, look for the Goto cell/ Auditory scan field. This is the mouse
button that you can use to access any cell when the mouse cursor is pointing at it.

NOTE: This method of navigating Grids is not recommended but it can be used as a
workaround if necessary.
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Using the Mouse as a Switch

You can choose to use your mouse as a switch device. To do this, open Switch Options and click
the tick box next to Use mouse buttons as switches.

The default controls for the mouse are:

e right mouse button to scan,
o middle mouse button to go to Cell/ auditory scan
¢ left mouse button to select.

If you would like to swap the functions of the left and right mouse buttons, you can select the tick
box next to Swap mouse buttons.

If you enable the mouse as a switch device, the Go to Cell/ Auditory scan will automatically
become the middle mouse button.

Use Mouse As Switch

[¥] Use mouse buttons as switches

(| Swap mouse buttons

Mapped Mouse Buttons For

Scan: Right Button
Goto cell / Auditory scan: Middle Button
Select: Left Button

$m rall 1A PR AU Ll [ < 1= o
o cell / Auditory scan: | Middie Buttor

Two Switches

You can select Two switches from the Switch Configuration section of Switch Options.
When you select Two switches, you will have a "scan" switch and a "select" switch.

The “scan” switch is used to navigate and the “select” switch is used to activate.
Switch Configuration
@ Two switches
) One switch

Scanrate | 1.0 seconds

You can use the Mapped Keyboard Keys For section to choose what keyboard key performs which
switch action.

Mapped Keyboard Keys For B3 Distog

Scan: Home

[_ome |
Select: End

Press A Key

To select a new keyboard key for a switch action, click the button next to the action you want to
change and then press the keyboard key that you want to replace it with. By default, the Scan switch
will be the “Home” key and the Select switch will be the “End” key.
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One Switch and Scan Rate

You can select One switch from the Switch Configuration section of Switch Options.
When you select One switch, you will have one switch: “select” for activating items.

To choose a new keyboard key for the “select” action, click the current “select” button in
the Mapped Keyboard Keys For section and then press the keyboard key that you want to replace
it with.

8] Dialog

Press A Key

The scanning will be performed automatically at timed intervals that you can set with the Scan
rate spin-box.

Switch Configuration
() Two switches
@ One switch

Scanrate 1.0 seconds &)

Scan rate refers to the amount of time it takes for the automatic scanning to move from one Cell to
the next.

Bounce Delay

Bounce delay refers to pre-defined amount of time between subsequent “scans” or “selects” before
allowing the next switch input. This can help the accuracy of navigation.

With Bounce Delay enabled and set to “2 seconds”, you would have to wait two seconds to use
another switch action after one was activated.

To activate bounce delay, click the radio button next to Enable in the Bounce Delay section
of Switch Options.

Bounce Delay
[¥] Enable

Bounce delay 0.2 seconds =

Use the spin-box next to Bounce delay to set the amount of time.
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Switch Display

You can change the appearance of the scan using the Display tab in Switch Options.

Configure the display properties for scan indicators
Indicator Border Width

Adjust border width size 10 pixels /%]

Scan Indicator

Colour: @

Auditory Scan Indicator

Audio busy colour:

The Indicator Border Width refers to the thickness of the border of the scan indicator. You can use
the spin box to change the width of the scan indicator.

You can change the colour of the Scan Indicator by clicking on the button next to Colour. The scan
indicator will be this colour when it is scanning.

# @ & (3
o % the Ubrory Goto e WA
= R = W
M lee = B ew L

You can change the colour of the Auditory Scan Indicator by clicking on the button next to Colour.
The scan indicator will be this colour when audio has been activated during a scan.

# @ & (3
o % the Ubrory Goto e WA
& R =
mw e B ew L

You can also choose what part of the scan indicator will be coloured using the Indicator
Overlay section.

Indicator Qverlay
@ Use Border and Fill

(7) Use Border only

When the Use Border and Fill radio button is selected, the entire scanned item will be coloured.

Goto the Gm
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When the Use Border Only radio button is selected, only the border of the scanned item will be
coloured.

& &

Goto the &ym

You can also change the colour of the scan indicator when it has reached the end of a scan group.

Visual Feedback Indicator for Group Scanning

This indicator only exists in Column /Row or Row / Column scanning to
indicate an exit from the current scan group.

Colour: @

To change the colour, click on the button next to Colour. The scan indicator will be this colour when
you reach the end of a group in Column/ Row or Row/ Column mode.

z @&

Goto the 6Gym

e
& (=

Goto the Supermorker

Setting the Scan Order for Trays

The scan order of items in a Tray must be defined when the Environment is created.

142

iz To set the scan order, either click the right mouse button on the Tray in Object-Mode and
T515] Select Set Scan Order. You must already have the Tray selected to use the Set Scan Order
icon on the toolbar.

alw

You will now see numbers attached to each object in the Tray. This is the default scan order (the
order in which the items were placed on the Tray).

® &

To create your own scan order for these items, click on the items in the scan order that you want.
When you have set the order thr numbers will turn blue.

G &

To finish, click the OK button next to the note “You are setting the order in which Cells will be
scanned. Press OK to finish.” at the top of the screen.
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Testing an Environment

To test a Grid, click on the green Play icon on the toolbar.

If you have not saved your Environment you will be asked if you want to Save, Use Without
Saving or Cancel. You can now use the Environment in the same way as a student.

When you have finished testing your Environment, you can click on the red Edit button to go
back to Design Mode.

NOTE: When you have tested your environment it is best to clear all the content that is in the
document. Otherwise this content will be saved with the Environment.

T S —— I e a—— e TR
fu 5% B e e e — - ~-lL-—_—-.—.—_—.—._- B
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Help Menu

You can use the Help menu to access the online manual, help sheets, reset help windows and find
out information about your version of SymWriter 2.

@,} View On-line Manual F1
Help Sheets
"% Reset Help Windows

About...

About Box - Finding your licence key

To look up information such as your SymWriter Release Version, Serial Number and Licensing
Information, choose About... from the Help menu.

NOTE: The network administrator may decide to hide the licence key information for security
reasons.
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Application Settings

You can access the Applications Settings dialog from either the Launcher, or in a document or Environment,
from the Tools menu by choosing Settings...

Using this dialog and the tabs, you will have an overview that you can use to customise basic
features of SymWriter.

Speech & Spelling
You can choose the way Speech will function, your preferred Speech Voices, language and whether
spelling errors will be indicated using the Speech & Spelling tab:

r
£ Application Settings
Speech ASpeling | Graghic Browser | System

Speech Spelling

These opbons affect the behaviour of speech at A You Type

koo ® Mk Speling Errors
7. Enable Speech Do Not Mark Speling Errors
Speak As You Type
Soesk After Letter
Spesk After Woed
Speak After Sentence

Default Speech Voices

Sedect Language(s): Sefect Defaudt Voce:
Czech ~ Mike -
Danish
English CA
English NZ
English UK
English US -

(o ][ come

Graphics Browser
You can choose your file-paths for personal and shared pictures with the Graphic Browser tab:

= Application Settings o]
Speech & Speling Graphic Browser System

Graphic Browser Default Locations

Location for Personsl Pctures Start locaton
C: Assers fredd Prctures/ ) 9 Widgt Penres
Personyl pichres

L for Shared Pictur:
ocation Ptures Shared pichures

C: Asers Publc Prctres/
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System

Using the System tab, you can set how many times you can perform the Undo function; you can
also set the measure of mouse wheel support, configure auto save settings and specify the image
cache size:

= Application Settings
Speech ASpeling | GraphicBrowser | System | Onine
Undo Mouse Wheel Support

Set how many times you can undo. Larger
rushers norease the memory usage of the
A0 AN

Set the maximum rumber of Ines you wesh to sorol each time
the mouse whedl s rotated

00 1% 2

Auto Save Image Cache Size

Set the mage cache sie for the program. Larger values wil
Pive better performance on computers with ots of memory
Auto save periodically saves a copy of your
curent document n the temporary drectory in
case arvything Qoes mrong with your computes

or the software whie you are working '
Ty s
Large
V. Enable Auto Save Every (Sminutes w Cache stze 1s set to 261953 kilobytes (kb).
Online

SymWriter Online

If you have registered a SymWriter Online account, you can synchronise it with the SymWriter
application using the Online tab. To synchronise your online account with the application, enter the
email address and password that you registered SymWriter online with and click Test. If you have
entered your information correctly, you will see the word 'Success!" appear accompanied by a green
tick icon.

= Application Settings x|
Speech & Speling | GraphicBrowser | System | Orine
Symwniter Oniine Proncy Settings
Emad: James Pwidgt.com My network uzes 3 proxy server

a Proxy v *
Passnord: sessesneces 7 bl

“ Success! Test

Proxy Settings

If your network uses a proxy server, you can use this section to configure it to work with SymWriter
Online. Proxy Settings

i Lo i V| My network uses a proxy server
A proxy server is used as a specialised way of accessing the

. _ . Proxy server detais
internet across an entire network. Effectively, a proxy server

acts as a buffer between a user and the internet itself. It is Serves:

recommended that either an expert user or administrator Port: 0

uses this section. V| My Proxy sarver requires authentication
Server credentials

Click the My network uses a proxy server checkbox to

. . . Us 5
unlock this section and enter your proxy server details. If S~
your proxy server requires authentication, click this Password:
checkbox and enter your Server credentials. Confirm Password:
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Reporting

This will permit your SymWriter 2 to anonymously report information back to Widgit Software about
commonly used features and functions. This will allow us to improve the software over time.

By clicking this checkbox, you acknowledge that you give permission for your usage data to be sent
to Widgit and stored.

Reporting

("] Allow this program to report usage statistics

What's this?
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Default Paths to File Locations

NOTE: The CSW 2.0 paths have the same default paths as CSW 1.0 on a standard installation.

NOTE: These paths are the default paths and may differ on different networks.

Win 7:

Shared Documents:
C:\Users\Public\Documents\Widgit\SymWriter

Personal Documents:
C:\Users\%username%\Documents\Widgit\SymWriter
- where %username% is a variable which the Windows will substitute.

Environments:
C:\Users\Public\Documents\Widgit\SymWriter\Environments

Environment Templates:
C:\Users\Public\Documents\Widgit\SymWriter\Environments\Templates

Topic Wordlists:
C:\ProgramData\Widgit\Common Files\Topic wordlists

Symbol Set Wordlists:
C:\ProgramData\Widgit\Common Files\Symbol Set Wordlists

User wordlist:
C:\Users\%username%\AppData\Roaming\Widgit\Common Files\User Wordlists
- where %username% is a variable which the Windows will substitute.

WinXP:

Shared Documents:
C:\Documents and Settings\All Users\Documents\Widgit\SymWriter

Personal Documents:
C:\Documents and Settings\%username%\My Documents\Widgit\SymWriter
- where %username% is a variable which the Windows will substitute.

Environments:
C:\Documents and Settings\All Users\Documents\Widgit\SymWriter\Environments

Environment Templates:
C:\Documents and Settings\All Users\Documents\Widgit\SymWriter\Environments\Templates

Topic Wordlists:
C:\Documents and Settings\All Users\Application Data\Widgit\Common Files\Topic Wordlists

Symbol Set Wordlists:
C:\Documents and Settings\All Users\Application Data\Widgit\Common Files\Symbol Set Wordlists

User wordlist:

C:\Documents and Settings\%username%!\Application Data\Widgit\Common Files\User Wordlists
- where %username% is a variable which the Windows will substitute.
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